Copyrights

© Cypress Semiconductor Corporation, 2015. The information contained herein is subject to change without notice. Cypress Semiconductor Corporation assumes no responsibility for the use of any circuitry other than circuitry embodied in a Cypress product. Nor does it convey or imply any license under patent or other rights. Cypress products are not warranted nor intended to be used for medical, life support, life saving, critical control or safety applications, unless pursuant to an express written agreement with Cypress. Furthermore, Cypress does not authorize its products for use as critical components in life-support systems where a malfunction or failure may reasonably be expected to result in significant injury to the user. The inclusion of Cypress products in life-support systems application implies that the manufacturer assumes all risk of such use and in doing so indemnifies Cypress against all charges.

Trademarks

PSoC is a registered trademark and PSoC Creator is a trademark of Cypress Semiconductor Corp. All other trademarks or registered trademarks referenced herein are property of the respective corporations.

Source Code

Any Source Code (software and/or firmware) is owned by Cypress Semiconductor Corporation (Cypress) and is protected by and subject to worldwide patent protection (United States and foreign), United States copyright laws and international treaty provisions. Cypress hereby grants to licensee a personal, non-exclusive, non-transferable license to copy, use, modify, create derivative works of, and compile the Cypress Source Code and derivative works for the sole purpose of creating custom software and/or firmware in support of licensee product to be used only in conjunction with a Cypress integrated circuit as specified in the applicable agreement. Any reproduction, modification, translation, compilation, or representation of this Source Code except as specified above is prohibited without the express written permission of Cypress.

Disclaimer

CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS MATERIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. Cypress reserves the right to make changes without further notice to the materials described herein. Cypress does not assume any liability arising out of the application or use of any product or circuit described herein. Cypress does not authorize its products for use as critical components in life-support systems where a malfunction or failure may reasonably be expected to result in significant injury to the user. The inclusion of Cypress’ product in a life-support systems application implies that the manufacturer assumes all risk of such use and in doing so indemnifies Cypress against all charges.

Use may be limited by and subject to the applicable Cypress software license agreement.
Appendix A: Board Schematics, Board Layout, and BOM

A.1 Board Schematics

A.2 Board Layout

A.3 Bill of Materials
Safety Information

Regulatory Compliance

The CY8CKIT-037 PSoC® 4 Motor Control Evaluation Kit is intended for use as a motor control development platform for hardware or software in a laboratory environment. The board is an open-system design, which does not include a shielded enclosure. Therefore, the board may cause interference with other electrical or electronic devices in close proximity. In a domestic environment, this product may cause radio interference. In such cases, the user may be required to take adequate preventive measures. Also, this board should not be used near any medical equipment or RF devices.

Attaching additional wiring to this product or modifying the product operation from the factory default may affect its performance and cause interference with other apparatus in the immediate vicinity. If such interference is detected, suitable mitigating measures should be taken.

The CY8CKIT-037, as shipped from the factory, has been verified to meet with the requirements of CE as a Class A product.

The CY8CKIT-037 contains ESD-sensitive devices. Electrostatic charges readily accumulate on the human body and any equipment, and can discharge without detection. Permanent damage may occur to devices subjected to high-energy discharges. Proper ESD precautions are recommended to avoid performance degradation or loss of functionality. Store unused CY8CKIT-037 boards in the protective shipping package.

End-of-Life/Product Recycling

The end of life for this kit is five years from the date of manufacture mentioned on the back of the box. Contact your nearest recycler to discard the kit.
General Safety Instructions

ESD Protection

ESD can damage boards and associated components. Cypress recommends that the user perform procedures only at an ESD workstation. If an ESD workstation is not available, use appropriate ESD protection by wearing an antistatic wrist strap attached to the chassis ground (any unpainted metal surface) on the board when handling parts.

Handling Boards

CY8CKIT-037 boards are sensitive to ESD. Hold the board only by its edges. After removing the board from its box, place it on a grounded, static-free surface. Use a conductive foam pad if available. Do not slide the board over any surface.
1. Introduction

Thanks for your interest in the CY8CKIT-037 PSoC® 4 Motor Control Evaluation Kit (EVK). This kit enables engineers to evaluate Cypress’s PSoC family of devices for motor control applications. Based on this kit, customers can create control solutions for three dominant motor types: permanent magnet synchronous motor (PMSM), stepper, and brushless DC (BLDC).

The Cypress PSoC family of devices integrates abundant internal resources for motor control applications, such as Timer Counter Pulse Width Modulator (TCPWM), SAR-ADC, comparators, opamps, and universal digital blocks (UDBs). In addition, an ARM® Cortex™ core enables high-performance motor control solutions on PSoC devices. Headers provided on the EVK board allow you to connect it to the CY8CKIT-042 PSoC 4 Pioneer Kit board to create a complete motor control system.

This kit guide documents the circuit structure of the Motor Control EVK board and explains how to configure it to create a solution for different motor types. It provides five example projects that cover sensored and sensorless BLDC control, PMSM sensorless field-oriented control (FOC), and stepper motor microstepping control. It also introduces the Bridge Control Panel (BCP) as a debugging tool in the motor control development process.

1.1 Kit Contents

The CY8CKIT-037 PSoC 4 Motor Control EVK includes the following contents, as shown in Figure 1-1:

- CY8CKIT-037 PSoC 4 Motor Control EVK main board
- AC-DC 24 V/2.0 A power adapter
- BLY172S-24V-4000 BLDC motor with sinusoidal back electromotive force
- USB-A to mini-B cable
- Configuration Jumpers
- Fuse
- Screwdriver
- Related documents:
  - Kit guide (this document)
  - Quick start guide
  - Release notes
Visit www.cypress.com/shop for more information. Inspect the contents of the kit; if any parts are missing, contact your nearest Cypress sales office for help.

1.2 Additional Learning Resources

Visit www.cypress.com for additional learning resources in the form of datasheets, technical reference manuals, and application notes.

- CY8CKIT-042 PSoC 4 Pioneer Kit _Schematic.pdf
- CY8CKIT-042 PSoC 4 Pioneer Kit_Layout.brd

1.3 Documentation Conventions

<table>
<thead>
<tr>
<th>Convention</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Courier New</td>
<td>Displays file locations, user-entered text, and source code:</td>
</tr>
<tr>
<td></td>
<td>C:...cd\icc\</td>
</tr>
<tr>
<td>Italics</td>
<td>Displays file names and reference documentation:</td>
</tr>
<tr>
<td></td>
<td>Read about the sourcefile.hex file in the PSoC Designer User Guide.</td>
</tr>
<tr>
<td>[Bracketed, Bold]</td>
<td>Displays keyboard commands in procedures:</td>
</tr>
<tr>
<td></td>
<td>[Enter] or [Ctrl] [C]</td>
</tr>
<tr>
<td>File &gt; Open</td>
<td>Represents menu paths:</td>
</tr>
<tr>
<td></td>
<td>File &gt; Open &gt; New Project</td>
</tr>
<tr>
<td>Bold</td>
<td>Displays commands, menu paths, and icon names in procedures:</td>
</tr>
<tr>
<td></td>
<td>Click the File icon and then click Open.</td>
</tr>
<tr>
<td>Times New Roman</td>
<td>Displays an equation:</td>
</tr>
<tr>
<td></td>
<td>2 + 2 = 4</td>
</tr>
<tr>
<td>Text in gray boxes</td>
<td>Describes cautions or unique functionality of the product.</td>
</tr>
</tbody>
</table>
This section describes the installation of the CY8CKIT-037 PSoC® 4 Motor Control EVK software and prerequisites.

2. Kit Installation

2.1 Prerequisite Software

You must install the PSoC Creator™ Integrated Design Environment (IDE) and USB-Serial Configuration Utility software before the kit can be used. All Cypress software installations require administrator privileges. Administrator privileges are not required to execute the software after installation. Close all other Cypress software that is currently running before you install the kit software.

2.2 Install Kit Software

Follow these steps to install the CY8CKIT-037 PSoC 4 Motor Control EVK software:

1. Download the CY8CKIT-037 software from the Cypress web page: www.cypress.com/CY8CKIT-037. The CY8CKIT-037 software is available in three different formats for download (see Figure 2-1):

   (a) CY8CKIT-037 CD ISO (Creator CD)  
   (b) CY8CKIT-037 Kit Setup (Kit Design Files, Creator, Programmer, USB-Serial Configuration Utility Tool, Documentation, Examples)  
   (c) CY8CKIT-037 Kit Only (Kit Design Files, Documentation, Examples)

   - **CY8CKIT-037 CD ISO**: This file is a complete package, stored in a CD-ROM image format, that you can use to create a CD or extract using ISO extraction programs, such as WinZip or WinRAR. The file can also be mounted like a virtual CD using virtual drive programs such as Virtual CloneDrive and MagicISO. This file includes all the required software, utilities, drivers, hardware files, and user documents.

   - **CY8CKIT-037 Kit Setup**: This installation package contains all files related to the kit. However, it does not include the Windows Installer or Microsoft .NET framework packages, Internet Explorer, and Adobe Reader. If these packages are not on your computer, the installer directs you to download and install them from the Internet.

   - **CY8CKIT-037 Kit Only**: This executable file installs only the kit contents, which include kit code examples, hardware files, and user documents. Use this package if the required software listed in step 4 is installed on your PC.

2. If you have downloaded the CD ISO file, mount it on a virtual drive. Extract the ISO contents if you do not have a virtual drive to which to mount. Double-click cyautorun.exe in the root directory of the extracted content or mounted ISO if “Autorun from CD/DVD” is not enabled on the PC. The installation window shown in Figure 2-2 will appear automatically.

   **Note**: If you are using the Kit Setup or Kit Only file, then go to step 3 for installation.

3. Click **Install CY8CKIT-037 EVK** to start the kit installation, as shown in Figure 2-2.
4. Select the folder in which you want to install the CY8CKIT-037 kit-related files. Choose the directory and click **Next**. When you click **Next** button, the CY8CKIT-037 ISO installer automatically installs the required software, if it is not present on your computer. Following is the required software:

- PSoC Creator 3.2 or later version: Download the latest version from [www.cypress.com/psoccreator](http://www.cypress.com/psoccreator).
- PSoC Programmer 3.23 or later version: Download the latest version from [www.cypress.com/programmer](http://www.cypress.com/programmer).

5. Select the **Typical installation** type in the **Product Installation Overview** window, as shown in Figure 2-3. Click **Next**.
When the installation begins, a list of packages appears on the installation page. A green check mark appears next to each package after successful installation.

6. Enter your contact information or select the option **Continue without Contact Information**. Click **Finish** to complete the CY8CKIT-037 kit installation.

After the installation is complete, the kit contents are available at `<Install_Directory>\CY8CKIT-037 Motor Control EVK`. The default locations are as follows:

- **Windows 7 (64-bit):** `C:\Program Files (x86)\Cypress\CY8CKIT-037 Motor Control EVK\1.0`
- **Windows 7 (32-bit):** `C:\Program Files\Cypress\CY8CKIT-037 Motor Control EVK\1.0`

**Note:** For Windows 7/8/8.1 users, the installed files and the folder are read-only. To change the property, right-click the folder and choose **Properties > Attributes** and then disable the **Read-only** option. Click **Apply** and **OK** to close the window.

After the installation is complete, the following are installed on your computer:

- **PSoC Creator 3.2 or later version**
- **PSoC Programmer 3.23 or later version**
- **USB-Serial Configuration Utility**
2.3 Uninstall Software

The software can be uninstalled using one of the following methods:

- Go to Start > Control Panel > Programs and Features; select the appropriate software package and click Uninstall.

- Go to Start > All Programs > Cypress > Cypress Update Manager > Cypress Update Manager; click Uninstall for the appropriate software package.

- Select the “CY8CKIT-037 Motor Control EVK 1.0 Rev **” row and click Uninstall. In the Product Installation Overview window, select Remove from the Installation Type drop-down menu. Follow the instructions to uninstall.

   Note: This method will uninstall only the kit software and not all the other software that may have been installed along with the kit software.
3. Kit Overview

3.1 CY8CKIT-037 Evaluation Kit Overview

The motor control system can be separated into two parts: the driver board and the controller board. The CY8CKIT-037 Motor Control EVK is the driver board, which contains the DC/DC power circuit, dual H-bridge circuit, motor current and bus voltage sampling and processing circuit, protection circuit, user configuration circuit, and connectors to the controller board. The controller board receives the signals, implements the proper algorithm to process them, and then generates control signals to the driver board to run the motor. Figure 3-1 shows the EVK board and its general description. CY8CKIT-037 EVK is the driver board; the CY8CKIT-042 kit works as controller board. They are interfaced with Arduino-compatible connectors.

Figure 3-1. General Description of EVK Board

3.2 Kit Operation and Configuration Guide

3.2.1 DC Power Supply Connector

There are two connectors for DC power input, J7 and J8, as Figure 3-2 shows. J7 is the standard power jack for DC adapters, with 12-V or 24-V DC output. J8 enables the kit to get input power from a general variable DC power supply with 24- to 48-V DC output voltage. The input current of both connectors can be up to 2 A. For schematic details, see Input Protection Circuit. CY8CKIT-042 gets 12 V from the DC/DC converter on CY8CKIT-037. The LDO on CY8CKIT-042 generates the 3.3-V supply for PSoC if the VDD on CY8CKIT-042 is configured as 3.3 V. If the VDD on CY8CKIT-042 is configured as 5 V, CY8CKIT-042 needs 5 V from the USB cable.

CAUTION: Do not connect power to both J7 and J8 simultaneously. Also, when using J7, connect the power cable to it before loading the AC supply at the AC/DC adapter to avoid a potential spark.
3.2.2 Motor Winding Connectors

J9 and J10 provide four pins for motor windings, as shown in Figure 3-3. The BLDC and PMSM motors use three pins, while the stepper motor application needs all four pins. Connection details are as follows:

For BLDC and PMSM:
- Pin 1–1A (A) → Motor winding A – Red
- Pin 2–2A (B) → Motor winding B – Yellow
- Pin 3–1B (C) → Motor winding C – Black

For the stepper motor:
- Pin 1–1A (A) → Motor winding 1 terminal A – Blue
- Pin 2–2A (B) → Motor winding 1 terminal B – Yellow
- Pin 3–1B (C) → Motor winding 2 terminal A – Red
- Pin 4–2B → Motor winding 2 terminal B – Green

For schematic details, see Connectors.

3.2.3 Hall Sensors Connector

J12 is the Hall sensors connector for the Sensored BLDC Motor Control example project, as Figure 3-4 shows. It is a five-pin connector. The details of each pin are as follows:

- 1 – VDD → Hall sensor board VDD – Red
- 2 – HALL A → Hall sensor A output – Blue
- 3 – HALL B → Hall sensor B output – Green
- 4 – HALL C → Hall sensor C output – White
- 5 – GND → Hall sensor board ground – Black

For schematic details, refer to Hall Sensors and BEMF Sensing Circuit.
3.2.4 Connectors to CY8CKIT-042 Board

*Figure 3-5* shows the Arduino-compatible connectors to the CY8CKIT-042 board: J1, J2, J3, and J4. You can plug the EVK board into the CY8CKIT-042 board through these connectors. For schematic details, refer to Connectors.

**Note:** Pin connectors J1, J2, J3, and J4 may become bent inadvertently when plugging the EVK board into CY8CKIT-042.

3.2.5 USB Connector

To monitor the real-time parameters while the motor is running, you can use the BCP (refer to Bridge Control Panel Monitor Tool Guide) to get data through the USB-to-UART bridge circuit on the EVK board during the debugging process. The USB-to-UART bridge circuit on the EVK board and PC can be connected by USB cable through the J11 connector, as *Figure 3-6* shows. For schematic details of the USB-to-UART bridge circuit part, refer to USB-to-UART Bridge Controller Circuit.
4. Kit Hardware Schematic Details

4.1 Block Diagram Overview

Figure 4-1 illustrates the CY8CKIT-037 hardware block diagram. The major features are as follows:

- Input protection circuit
- DC/DC switching regulator
- MOSFET dual H-bridge and dual H-bridge PWM drivers
- Phase current detecting and processing circuit
- Hall and back electromagnetic force (BEMF) sensing circuit
- USB-to-UART bridge controller circuit
- Connectors
- Test points and LEDs

Figure 4-1. CY8CKIT-037 Hardware Block Diagram
4.2 Input Protection Circuit

Figure 4-2 shows the input protection circuit that consists of three parts: overcurrent protection by fuse F1 or F2, power supply reverse protection by Schottky diode D2, and input voltage inrush protection by varistor VR1. Notice that there are two parallel fuses: F1 is a PTC resettable fuse, and F2 is the common thermal fuse. F2 is populated onboard by default. You can also use PTC fuse F1 to replace F2 according to your requirements.

CAUTION
Do not populate both F1 and F2 on the board. Otherwise, when an overcurrent condition occurs. F1 and F2 cannot cut off the circuit, which will lead to component damage on the board.

4.3 DC/DC Switching Regulator

Figure 4-3 shows the DC/DC switching regulator circuit on the EVK board. It converts the voltage \( V_{\text{in}} \) (output of the input protection circuit, 0.5 V to 1 V lower than the input voltage) to +12 V. This switching converter is a buck regulator using LM5005. LM5005 has an internal 75-V N-channel buck switch with an output current capability of 2.5 A. It is designed to take an input in the range of 7–75 V and provides 12-V output with 1.5-A current capability when the input voltage is higher than 13 V.

When the voltage at the SD pin of LM5005 is less than 1.225 V, the IC will go into an inactive state. The external R1 and R2 divider with 10 k\( \Omega \) and 2 k\( \Omega \) will give exactly 1.225 at 7.35-V input. If the input goes below 7.35 V, LM5005 will be in an inactive state.
The +12V output of the regulator provides power to the dual H-bridge driver chips and the PSoC 4 Pioneer Kit. The other circuits and chips on the EVK board also need a power supply in the range of 2.7 V to 5.5 V, which is VDD. But the EVK board does not contain this converter. It gets this power from the controller board through Arduino headers.

4.4 MOSFET Dual H-Bridge and Dual H-Bridge PWM Drivers

This part contains four half-bridge circuits and four driver circuits. For BLDC and PMSM control, you can use three half-bridge circuits to form a standard three-phase inverter. For the stepper motor, you can control two windings of the stepper motor separately via the dual H-bridge.

Figure 4-4 shows the driver circuit, containing four ASIC driver chips (IR2101) and relative peripheral components. IR2101 can source 100-mA or sink 210-mA current for MOSFETs. Each chip can drive two MOSFETs of a half-bridge, and its high-side PWM operates with a floating supply by a peripheral bootstrap circuit.

Figure 4-5 shows the MOSFET dual H-bridge. There are four half bridges in total, each one serving a motor phase or winding. Considering the compatibility for different motor control types, the population of components J19, J20, and J21 needs to be adjusted to fit different motor type applications.
4.5 Phase Current Detecting and Processing Circuit

As Figure 4-5 shows, three sensing resistors, R34, R35 and R36, are inserted into three half-bridges. When the motor is running, the winding current floats through these resistors. So, detecting the voltage on the sensing resistors can get the phase current of the motor windings. Because of the sensing resistors' low value and the noise of the running motor, you need to amplify and filter the voltage signal. Figure 4-6 shows the current detecting and processing circuit for winding A and winding C.

The core of this part is the amplifier. You use PSoC internal opamps on the controller board. J18 and J23 are used only for PMSM FOC control because in the FOC application, the winding current can be both positive and negative. J18 and J23 add 1/2 VDD bias voltage to the sensing signal to make it always positive.

J22 is used only for the sensorless BLDC application, because the sensorless BLDC firmware uses an inside low-power comparator (LPComp). P1_1 is dedicated to its negative terminal, which needs to be connected to the Vin divider circuit (P2_6/Vin). R49 will change the divider proportion. You need to short pin 2 and pin 3 of J22 to remove R49 from the circuit in the Sensorless BLDC Motor Control example project.

Figure 4-6. Current Detecting and Processing Circuit

Figure 4-7 shows the external two-phase winding current comparing circuit, which is used only in the stepper motor application. The positive terminal input is the current sensing signal after amplifying and filtering, and the negative terminal input is the current reference set by the internal IDAC. The comparator output is routed to the PWM kill terminal to shut down the PWM output, forcing the winding current to follow the IDAC current reference.
Figure 4-7. Two-Phase Winding Current Comparing Circuit

Figure 4-8 shows the overcurrent protection circuit. R60, R61, and R62 add the three-phase winding current, and the external opamp U7 amplifies and filters the sum of the currents. Its output is routed to the positive terminal of the internal LPCmp to be compared with the overcurrent threshold set by the IDAC.

Figure 4-8. Overcurrent Protection Circuit
4.6 Hall Sensors and BEMF Sensing Circuit

Both sensored and sensorless BLDC motor can be rotated with the EVK board. The sensored BLDC gets its rotor position from the Hall sensors, and the sensorless BLDC gets its rotor position by detecting the BEMF signal from the stator winding. Figure 4-9 shows the Hall sensor interface. The Hall sensor output is in an open-collector structure, so the interface adds pull-up resistors to make the PSoC device receive the correct Hall sensor signal.

![Figure 4-9. Hall Sensor Interface](image)

Figure 4-10 shows the voltage divider and filter circuit for BEMF detecting. Three phases of the Hall sensor and BEMF signals are routed to jumpers J13, J14, and J15, as shown in Figure 4-11. Users can select sensored or sensorless configuration via the three jumpers.

![Figure 4-10. Sensorless BLDC BEMF Detecting Circuit](image)

Figure 4-11 shows that the two Hall sensor and BEMF signals, as well as the two external comparator output kill signals of the stepper motor, are routed to J16 and J17. Since the GPIO pin numbers of PSoC 4 are limited, these signals need to share two GPIO pins. Be sure to configure J16 and J17 correctly for the BLDC and stepper motor applications.

![Figure 4-11. Signal Configuration Jumpers](image)
4.7 USB-to-UART Bridge Controller Circuit

Figure 4-12 shows the USB-to-UART bridge controller used for transferring data, such as speed and winding current, that you want to monitor on the BCP. The bridge controller receives the data from PSoC 4 on CY8CKIT-042 over UART and transmits it over USB to be monitored using BCP software.

4.8 Connectors

There are several connectors on the EVK board. Figure 4-13 shows the input power connectors. J7 is the standard power jack for DC adapters, with an output from 12 V to 24 V. J8 can accept an input voltage from 24 V to 48 V through raw wire from a general variable DC power supply. The input current of both connectors can be as high as 2 A.

Figure 4-14 shows the motor winding connectors. The two connectors provide four pins in total. The BLDC motor contains three windings with a common neutral point inside the motor. It uses only three pins. The stepper motor contains two independent windings, so it needs all four pins.
Figure 4-14. Motor Winding Connectors

Figure 4-15 shows the connectors to the CY8CKIT-042 board. The layout of J1, J2, J3, and J4 on the EVK board is designed pin-to-pin with J1, J2, J3, and J4 on the Pioneer Kit, so users can plug the EVK board directly into the Pioneer Kit.

Figure 4-15. Connectors to CY8CKIT-042
4.9 Test Points

The EVK board provides many test points of critical signals, making it convenient for users to debug in the development process. Test points cover driver PWMs, power output and ground, winding current, and IDAC reference output. You can observe and monitor these signals using probes. Figure 4-16 show some instances of test points.

Figure 4-16. Test Points

CAUTION Do not power the kit through these test points to avoid damage to the board.
5. Example Projects

Cypress provides five example projects with the Motor Control EVK board package, which can help you accelerate the motor control development process based on PSoC 4.

5.1 Configuration Jumpers for Different Motor Types

CY8CKIT-037 supports three motor types: BLDC, PMSM, and stepper. When switching between different motor types or algorithms, the EVK board needs to be reconfigured via jumpers J13–J24. The jumper configuration table is printed on the top layer of the EVK board, as shown in Figure 5-1.

5.2 Sensored BLDC Motor Control Example Project

5.2.1 Sensored BLDC Background

BLDC motors are widely used in industrial applications, home appliances, and vehicle systems. Such motors consist of a multi-pole permanent magnet placed on the rotor and several windings. In the BLDC motor, the commutation is controlled electronically. The motor requires the stator windings to be energized in a particular sequence. To implement this sequence, it is important to know the rotor position. The simplest way is to use rotor position sensors. The sensors can be optical, magnetic (Hall or magneto-resistance effect based), or inductive. The Hall sensor is selected in most applications for its high accuracy and low cost.

Hall sensors are embedded in the stator. When the rotor magnetic poles pass near the Hall sensors, they supply a high or low signal, indicating that the north or south poles are passing nearby. The rotor position is derived from the exact combination of the three Hall sensor signals. Three position sensors can provide six effective states (except 000 and 111) and separate a whole electrical space into six parts, each having a 60-degree electrical angle. Figure 5-2 gives a timing diagram of the sensor output and the required motor driving voltage. The optional use of a PWM provides speed or torque control as shown in phases A, B, and C. The duty cycle of the modulated output control signal (PWM) is varied to change the speed and torque of the motor.
5.2.2 Sensored BLDC Motor Control Example Project Overview

Figure 5-3 illustrates the block diagram of the Sensored BLDC Motor Control example project based on PSoC 4A.

The input control signals to the PSoC 4 device are as follows.

- **Speed command**: Analog input pin that measures the voltage across a potentiometer to set the desired speed of rotation (one analog input pin).
- **Motor current detection**: Analog input pin that detects and cuts off the power device driver to protect the motor when an overcurrent condition is detected (see Firmware Introduction) (one analog input pin).
- **Hall sensors**: Three digital input pins connected to the outputs of the Hall sensors from the motor. These sensor inputs provide the position of the motor and are used to control the commutation by varying the PWM output signals to the power driver (three digital input pins).

- **Start/stop control**: Digital input connected to a switch to start and stop motor rotation (one digital input pin).

Outputs from the PSoC 4 device are power device driver signals.

- PWM signals to the high side of the MOSFET driver (three digital output pins)
- PWM signals to the low side of the MOSFET driver (three digital output pins)

### 5.2.3 Control Schematic Overview

The Sensored BLDC Motor Control example project firmware was developed in PSoC Creator 3.2 or later version. Its schematic was separated into two pages according to their function. Figure 5-4 shows the "PWM Drive and Commutate" page. The three Hall sensor signals are imported by pins “Hall1,” “Hall2,” and “Hall3.” Then “Lut_Cmut” outputs the PWM signal to the motor windings according to the Hall signals and its internal commutation table. “PWM_Drive” generates the real-time duty cycle to follow the user’s RPM request.

**Figure 5-4. PWM Drive and Commutate Schematic**

![PWM Drive and Commutate Schematic](image)

Figure 5-5 shows the “ADC sampling” schematic. “ADC_SAR_Seq_1” is the SAR ADC to detect and measure the bus voltage and potentiometer voltage.

**Figure 5-5. ADC Sampling Schematic**

![ADC Sampling Schematic](image)

Figure 5-6 shows the “Speed Measurement” schematic. “Counter_Spd” uses one Hall signal to measure the RPM of the motor. It can work as real-time feedback of the closed-loop speed control.

**Figure 5-6. Speed Measurement Schematic**

![Speed Measurement Schematic](image)
Figure 5-6. Speed Measurement Schematic

Figure 5-7 shows the “Overcurrent Protection” schematic. The motor current is detected by the sensing resistor and amplified by the external or internal opamp. The current signal is routed to the positive terminal of the internal low-power comparator “LPComp_OC.” The negative terminal of the comparator is the overcurrent threshold set by the internal IDAC “IDAC_Iref.” If overcurrent happens, “LPComp_OC” will trigger an interrupt, and an overcurrent action will be executed in its ISR.

5.2.4 Firmware Introduction

Figure 5-8 shows the flow chart of the main loop function. The project schematic in Figure 5-4 shows that hardware performs the commutation. So, the firmware processes only the closed-loop speed control, button detecting, and protective action.
5.2.5 Running the Sensored BLDC Motor Control Example Project

5.2.5.1 Step 1 – Configure CY8CKIT-042
Select 5 V as the VDD power at jumper J9 on the Pioneer Kit, and always keep the USB cable connected to the Pioneer Kit because the Pioneer Kit does not provide a 5-V converter. It gets 5-V power directly from the USB port of the PC. Figure 5-9 shows the CY8CKIT-042 configuration.

Figure 5-9. CY8CKIT-042 Configuration for Sensored BLDC Motor Control Example Project

5.2.5.2 Step 2 – Configure CY8CKIT-037
Configure the board via jumpers J13–J24 for the Sensored BLDC Motor Control example project (“HALL SENSOR BLDC” row in Figure 5-1). The CY8CKIT-037 is configured for sensored BLDC control by default. If you have not made any changes since receiving it from Cypress, bypass this step and go to Step 3 – Plug CY8CKIT-037 into CY8CKIT-042. Figure 5-10 shows the jumper overview after configuration.

Figure 5-10. Configuration for Sensored BLDC Motor Control Example Project
5.2.5.3 Step 3 – Plug CY8CKIT-037 into CY8CKIT-042

Plug the EVK board into the Pioneer Kit via connectors J1–J4, as shown in Figure 5-11.

Figure 5-11. Plug CY8CKIT-037 EVK into CY8CKIT-042 Pioneer Kit

5.2.5.4 Step 4 – Connect the Power Supply and Motor

Connect the BLDC motor to the EVK board, including windings to J9/J10 and Hall sensor to J12. The wire sequence and color for the motor windings and Hall sensor should be exactly as shown in Figure 5-12. Refer to Motor Winding Connectors and Hall Sensors Connector for instructions. Then connect a 24-V power adapter to J7, and connect the other end of the USB cable to the PC. When LED1 is red, it indicates power is on. If it is not glowing, the fuse F2 may be broken. Please change the F2 with the provided backup fuse.

Figure 5-12. Connect Motor and Power Supply
5.2.5.5 Step 5 – Build the Project and Program PSoC 4

Open the Sensored BLDC Motor Control example project in PSoC Creator 3.2 or later version, as shown in Figure 5-13. Choose Build > Build Sensored BLDC Motor Control to start building the project, and then choose Debug > Program to program the chip.

Figure 5-13. Open the Sensored BLDC Motor Control Example Project

5.2.5.6 Step 6 – Press the SW2 Button to Start Motor Rotation

Ensure that the other end of the USB cable is connected to the PC in this step; otherwise, the motor will not start rotating. Press the SW2 button to start motor rotation (refer to Figure 5-14). If the motor does not rotate and you observe LED2 blinking, an error has occurred. If so, first check that step 1 through step 5 have executed correctly. Then press the Reset button and press the SW2 button again. If LED2 still blinks, there must be a problem in the hardware or software. You have to debug it or contact Cypress for technical support.

Figure 5-14. Buttons and Status LED

CAUTION During the debugging process, if you modify the code in the firmware, make sure that the changes do not turn on both the high-side and low-side MOSFETs.

CAUTION Do not remove jumpers while the kit is powered. This may damage the kit.
5.2.6 Adapting the Example Project to another Motor

This example project can be changed to rotate other sensored BLDC motors. Some parameters in the project firmware need to be modified according to your specific motor characteristic and functional requirements. These parameters are defined as a struct in motor.h.

```c
typedef struct
{
    uint8   Dir;    /*Direction*/
    uint16  speedRpm;    /* Actual motor speed*/
    uint16  speedRpmRef;  /* motor speed command value*/
    uint16  kp;        /* Proportional coeffient of PID*/
    uint16  ki;        /* Integral coeffient of PID*/
    uint16  maxSpeedRpm; /* Motor parameters*/
    uint16  minSpeedRpm; /* Motor parameters*/
    uint8   polePairs;  /*POLE PAIRS*/
    uint8   maxCurr;     /*Over current threshold*/
}UI_DATA;
```

The struct variable is in motor.c and is initialized in motor.c by function Init_UI_FW.

```c
UI_DATA UI_Data;
void Init_UI_FW(void)
{
    /* Setting UI Initial parameter*/
    UI_Data.Dir = CLOCK_WISE;
    UI_Data.maxSpeedRpm = 4000;
    UI_Data.minSpeedRpm = 500;
    UI_Data.speedRpmRef = 1000;
    UI_Data.polePairs = 4;
    UI_Data.maxCurr = MAX_CURR_MEDIUM;
    UI_Data.kp = 500;
    UI_Data.ki = 50;
}
```

This function initializes the parameters before the motor begins running, and the initializing value is dedicated for the motor shipped from Cypress in the kit package. If you want to use your own motor and have different functional requirements such as RPM or direction, change the initializing value in this function.

5.3 Sensorless BLDC Motor Control Example Project

5.3.1 Sensorless BLDC Background

Various methods can be employed to control the BLDC motor. The simplest way is to use Hall position sensors. However, sensors increase cost and add reliability problems in motors operating in harsh environments where demands for sensor robustness are high. The increasing power of embedded computing, coupled with lower prices for power semiconductors and microcontrollers, has allowed more sophisticated methods of motor control. One popular technique is to use a BEMF signal, which is induced by revolving the rotor permanent magnet around the drive coils.

Most BLDC motors have a three-phase winding topology with a star connection. It is driven by energizing two phases simultaneously, while the other phase is kept afloat. The key to BLDC commutation is to sense the rotor position and then energize the phases that produce the maximum amount of torque. The rotor travels 60 electrical degrees at every commutation step. The appropriate stator current path is activated when the rotor is 120 degrees away from alignment with the corresponding stator magnetic field. It is then deactivated when the rotor is 60 degrees from alignment. The next circuit is activated and the process repeats.
Figure 5-15 shows that every commutation sequence has one winding energized positive, the second is negative, and the third winding is left open. The voltage polarity of BEMF crosses from positive to negative or from negative to positive (zero-crossing) between two commutations. Ideally, the zero-crossing of BEMF occurs at 30 electrical degrees after the last commutation and 30 electrical degrees prior to the next commutation. By measuring the zero-crossing of BEMF and the 30-degree time interval, the controller can perform the commutation without a position sensor.

Figure 5-15. General Operating Waveforms of Phase Voltages and Currents

5.3.2 Sensorless BLDC Motor Control Example Project Overview

Figure 5-16 illustrates the block diagram of the Sensorless BLDC Motor Control example project based on PSoC 4A. The input control signals to the PSoC 4 device are the following.

- **Speed command**: An analog input pin that measures the voltage across a potentiometer to set the desired speed of rotation (one analog input pin).
- **Motor current detection**: An analog input pin to detect and cut off the power device driver to protect the motor when an overcurrent condition is detected (see Control Schematic Overview) (one analog input pin).
- **Half Vbus**: An analog input pin that routes half-bus voltage to the negative terminal of the internal low-power comparator.
- **BEMF divider voltage**: Three analog input pins connected to the outputs of the BEMF divider circuit. These BEMF inputs are routed to the internal AMUX, and then the AMUX selects the proper BEMF signal sequentially to compare with the half Vbus to get the zero-crossing point of the non-energized winding.
- **Start/stop control**: A digital input connected to a switch to start and stop rotation of the motor (one digital input pin).

Outputs from PSoC 4 are power device driver signals.

- PWM signals to the high side of the MOSFET driver (three digital output pins)
- PWM signals to the low side of the MOSFET driver (three digital output pins)
5.3.3 Control Schematic Overview

The Sensorless BLDC Motor Control example project firmware was developed in PSoC Creator 3.2. Its schematic was separated into two pages according to their function. Figure 5-17 shows the “BEMF Checking” page. Three BEMF signals are routed to the internal AMUX “AMux_1.” It will select a nonenergized AMUX and compare it with the half Vbus. If zero-crossing output happens, the internal low-power comparator “BEMF_Comp” will toggle its output. The logic gating circuit on the right side of “BEMF_Comp” generates a pulse when “BEMF_Comp” toggles its output. So PSoC 4 can get a pulse at each zero-crossing point. The pulse triggers an interrupt, and the relevant code will be executed in its ISR.

Figure 5-17. BEMF Checking Schematic

Figure 5-18 shows the “PWM Drive and Commutation” page. “SectorCtrl” indicates the current rotor position. It is dynamically changed in firmware by the zero-crossing detecting ISR. “Lut_Cmut” outputs the PWM signal to the motor windings according to the “SectorCtrl” output and its internal commutation table. “PWM_Drive” generates the right duty cycle to follow the user’s RPM request. “Counter_Spd” is used to measure motor speed; it can work as real-time feedback of the closed-loop speed control.
5.3.4 Firmware Introduction

The Sensorless BLDC Motor Control example project employs the typical three-step startup algorithm. The BEMF amplitude of BLDC is proportional to the motor speed. If the motor stops, there is no BEMF. When the motor rotates at a low speed, the BEMF is too weak to be detected. Therefore, before the BEMF can be measured by the firmware, there is a “free-running” stage in which the BLDC motor rotates step by step to acquire the initial BEMF zero-crossing signal before running sensorless control.

When rotating at a certain speed with open-loop stepping stimulation, the rotor position is approximately 90 electrical degrees ahead of that when run correctly under sensorless control. As a result, the BEMF zero-crossings cannot be sensed. To observe the zero-crossings, it is necessary to accelerate the motor at a certain rate.

In this stage, the PWM duty cycle increases gradually, and the commutating period is longer than usual. A ramp-up table in F/W defines the timeout of every commutating period. The value of the table content is a result of experiments based on different motor types. When sufficient valid zero-crossing events are detected, F/W enters the normal synchronous running stage. If F/W cannot detect sufficient valid zero-crossing events during a period of time, an error occurs and BLDC must stop and wait for the next round of the free-running stage. Figure 5-19 shows the starting sequence.

The main part of the sensorless startup and normal running control algorithm is in the PWM ISR. Figure 5-20 shows a flow chart of the PWM ISR.
5.3.5 Running the Sensorless BLDC Motor Control Example Project

5.3.5.1 Step 1 – Configure CY8CKIT-042
Select 5 V as the VDD power at jumper J9 on the Pioneer Kit, and always keep the USB cable connected to the Pioneer Kit because the Pioneer Kit does not provide a 5-V converter. It gets 5-V power directly from the USB port of the PC. Figure 5-9 shows the configuration.

5.3.5.2 Step 2 – Configure CY8CKIT-037
Configure the board via jumpers J13–J24 for the Sensorless BLDC Motor Control example project (“SENSORLESS BLDC” row in Figure 5-1). Figure 5-21 shows the EVK board configured for the Sensorless BLDC Motor Control example project.

Figure 5-20. PWM ISR Flow Chart

Figure 5-21. EVK Board Configuration for Sensorless BLDC Motor Control Example Project
5.3.5.3 Step 3 – Plug CY8CKIT-037 into CY8CKIT-042
Plug the EVK board into the Pioneer Kit via connectors J1–J4, as shown in Figure 5-11.

5.3.5.4 Step 4 – Connect the Power Supply and Motor
Connect the BLDC windings to J9 and J10 on the EVK board. Then connect the 24-V power adapter to J7, and connect the other end of the USB cable to the PC, as shown in Figure 5-22. When LED1 is red, it indicates power is on. If it is not glowing, the fuse F2 may be broken. Please change the F2 with the provided backup fuse.

5.3.5.5 Step 5 – Build the Project and Program PSoC 4
Open the Sensorless BLDC Motor Control example project in PSoC Creator 3.2 or later version, as shown in Figure 5-23. Choose Build > Build Sensorless BLDC Motor Control to start building the project, and then choose Debug > Program to program the chip.

CAUTION
During the debugging process, if you modify the code in the firmware, make sure that the changes do not turn on both the high-side and low-side MOSFETs.
5.3.5.6 Step 6 – Press the SW2 Button to Start Motor Rotation

Ensure that the other end of the USB cable is connected to the PC in this step; otherwise, the motor will not start rotating. Press the SW2 button to start motor rotation (refer to Figure 5-14). If the motor does not rotate and you observe LED2 blinking, it indicates that an error has occurred. If so, first check that step 1 through step 5 have executed correctly. Then press the Reset button and press the SW2 button again. If LED2 still blinks, there must be a problem in the hardware or software. You have to debug it or contact Cypress for technical support.

CAUTION Do not remove jumpers while the kit is powered.

5.3.6 Adapting the Example Project to another Motor

This example project can be changed to rotate other sensorless BLDC motors. Some parameters in the project firmware need to be modified according to your specific motor characteristic and functional requirements.

5.3.6.1 Tuning Parameters Overview

This example project provides two structure definitions for tuning purposes. One structure is “BLDC_Config_T,” which is defined in the parameters.h file. It contains all the constant parameters used in BLDC rotation. The following code illustrates the members of the “BLDC_Config_T” structure.

```c
typedef struct _BLDC_Config
{
    /*-------------------------------------------------------------*
     * motor parameters                                           *
     *-------------------------------------------------------------*/
    uint8  polePairNumber;
    /*-------------------------------------------------------------*
     * general parameters                                          *
     *-------------------------------------------------------------*/
    Direction_T  direction;
    uint16  initSpeedRefRpm;
    /*-------------------------------------------------------------*
     * PID parameters                                               *
     *-------------------------------------------------------------*/
    Uint32   kp;
    Uint32   ki;
    /*-------------------------------------------------------------*
     * preposition parameters                                       *
     *-------------------------------------------------------------*/
    uint16   prepositionTime;
    uint16   prepositionDuty;
    /*-------------------------------------------------------------*
     * startup parameters                                           *
     *-------------------------------------------------------------*/
    uint16   startDuty;
}
```

* BLDC_Config_T

This structure contains all the constant parameters used in BLDC rotation.
A variable of "BLDC_Config_T" is defined in the BLDCController.c file as follows.

```c
BLDC_Config_T    BLDC_Config;
```

The parameters in "BLDC_Config_T" are initialized in the BLDC_ParameterInit function (see the following code), which is executed only once when the system powers up. Generally, these parameters should not be changed during motor rotation, and a number of macros are also defined in the parameters.h file to provide the initial value. You can modify the macro values for tuning based on application requirements or different motors. Note that macro values should be modified before the code example is compiled. Once the project is compiled for the binary hex file, changing macro values has no effect.

However, if some additional debugging code is developed to support run-time tuning via the communication interface, such as RS232, SPI, or I2C, real-time updating of the parameters in the "BLDC_Config" variables is possible. Note that the Cypress code example does not include this kind of debugging code. Kit users must develop it themselves.

```c
void BLDC_ParameterInit(void)
{
    /* motor pole-pair number */
    BLDC_Config.polePairNumber = MOTOR_POLE_PAIR_NUM;

    /* motor rotation direction, options are CLOCK and COUNTER_CLOCK */
    BLDC_Config.direction = CLOCK;

    /* speed reference in RPM unit */
    BLDC_Config.initSpeedRefRpm = INIT_SPEED_REF_RPM;
```
Another structure is “BLDC_Control_T,” which is defined in the BLDCController.h file. It contains the system running status, such as the current running speed in RPM, the output of PID control, and so on. This structure is updated in real time during motor rotation. Monitoring these values is helpful in understanding system performance and troubleshooting. The following code illustrates the members of the “BLDC_Control_T” structure.

```
typedef struct _Run_Control
{
    uint8 runFlag;
    Error_Code_T errorCode;
    uint8 sector;
    uint8 checkFallingEdge;
    uint8 inNormalRun;
    uint16 speedMeasuredRpm;
    uint16 speedRefRpm;
    uint16 speedGivenRpm;
} _Run_Control;
```

```c
/* kp for PID control */
BLDC_Config.kp = KP_INITIAL_VALUE;
/* ki for PID control */
BLDC_Config.ki = KI_INITIAL_VALUE;

BLDC_Config.startDuty = START_PWM_DUTY;
BLDC_Config.freerunDuty = FREERUN_PWM_DUTY;
BLDC_Config.startCheckPeriod = START_ZC_CHECK_PERIOD;
BLDC_Config.startStageWait = START_STAGE_WAIT_COUNT;
BLDC_Config.decStageInterval = DEC_STAGE_INTERVAL;
BLDC_Config.freerunStageWait = FREERUN_STAGE_WAIT_COUNT;
BLDC_Config.accStageInterval = ACC_STAGE_INTERVAL;
BLDC_Config.accStageWait = ACC_STAGE_EXEC_COUNT;
BLDC_Config.accDutyStep = ACC_STAGE_DUTY_STEP;
BLDC_Config.accTimeStep = ACC_STAGE_TIME_STEP;

BLDC_Config.prepositionTime = PREPOSITION_WAIT_TIME;
BLDC_Config.prepositionDuty = PREPOSITION_PWM_DUTY;

BLDC_Config.speedCloseLoopWait = SPEED_CLOSE_LOOP_DELAY;
BLDC_Config.zcCheckSkipCount = ZC_CHECK_SKIP_COUNT;
}
Example Projects

uint16 commutateStamp;
uint16 zeroCrossStamp;
uint16 zeroCrossPeriod;
uint16 delayTime;

int32 pidOutput;
int32 pidSpeedErr;

}BLDC_Control_T;

A variable of “BLDC_Control_T” is defined in the BLDCController.c file as follows.

BLDC_Control_T BLDC_Control;

A macro (see the following code) is defined to reset the values of “BLDC_Control” in the BLDCController.c file. This macro is executed in the BLDCControllerInit function when the system powers up and in the BLDCCStart function before the motor starts rotation every time.

#define BLDC_CONTROL_INIT_CODE
{\
  BLDC_Control.runFlag = FALSE;\
  BLDC_Control.errorCode = NO_ERROR;\
  BLDC_Control.sector = 1;\
  BLDC_Control.checkFallingEdge = FALSE;\
  BLDC_Control.inNormalRun = FALSE;\
  BLDC_Control.speedMeasuredRpm = 0;\
  BLDC_Control.speedRefRpm = 0;\
  BLDC_Control.speedGivenRpm = 0;\
  BLDC_Control.commutateStamp = 0;\
  BLDC_Control.zeroCrossStamp = 0;\
  BLDC_Control.zeroCrossPeriod = 0;\
  BLDC_Control.delayTime = 0;\
  BLDC_Control.pidOutput = 0;\
  BLDC_Control.pidSpeedErr = 0;\
}

5.3.6.2 Tuning Startup Procedure

The startup procedure is important for the sensorless BLDC application. At the beginning of startup, the BEMF is not high enough to detect a stable zero-crossing point, which is used in sensorless control for commutation. The BLDC motor must rotate at a certain speed to generate a high enough BEMF in open-loop mode for a specified time. Then the system switches to position closed-loop mode for zero-crossing point tracking and commutation on demand. After position closed-loop mode is stable, the system enables speed closed-loop mode to force motor rotation close to a given speed reference. Once speed closed-loop mode is stable, the BLDC motor works in normal run mode.

The tuning startup procedure is performed for many possible reasons. One is that a different startup load is applied to the motor; another is that a changing motor requires performance tuning to match the new motor characteristic. The code example provides a multistage startup procedure, as shown in Figure 5-24. This procedure contains six stages, and the PWM duty cycle varies for the different stages.
A firmware counter is used to detect the zero-crossing for each stage. Stage switching happens only when the firmware counter is timed out. "startCheckPeriod" sets the timeout period for the firmware counter.

```c
uint16 startCheckPeriod;
```

Stage PREPOSITION aligns the motor rotor to a given position for a while and prepares for starting rotation. Two parameters are tunable for this stage. "prepositionTime" is a threshold for an internal counter that counts how many times stage PREPOSITION is executed. A larger "prepositionTime" value lengthens the duration of the PREPOSITION stage. "prepositionDuty" is the duty cycle for stage PREPOSITION. A larger "prepositionDuty" value generates a larger preposition torque.

```c
uint16 prepositionTime;
uint16 prepositionDuty;
```

Stage START makes the motor rotate from the stop state. Change "startDuty" for a different load status. A larger value generates a larger startup torque for a heavy load. "startStageWait" indicates how long stage START is executed. It is a threshold for an internal counter that counts how many times stage START is executed. A larger "startStageWait" value lengthens the duration of stage START.

```c
uint16 startDuty;
uint8 startStageWait;
```

Stage DECREASE follows stage START. In this stage, the duty cycle of PWM is decreased by 1 every time until the duty reaches the "freerunDuty," which is the minimum duty cycle for the startup procedure. Then the motor maintains rotation in accordance with the "freerunDuty" duty cycle in stage FREERUN. "decStageInterval" sets the interval between two decrease operations. A larger value results in a slower slope of the decrease curve. "freerunStageWait" indicates how long stage FREERUN is executed. It is a threshold for an internal counter that counts how many times stage FREERUN is executed. A larger "startStageWait" value lengthens the duration of stage FREERUN.

```c
uint16 freerunDuty;
uint8 decStageInterval;
uint8 freerunStageWait;
```

After stage FREERUN, the motor starts to accelerate for a higher BEMF in stage ACCELERATION. "accStageInterval" sets the interval between two decrease operations. "accStageWait" indicates how long the stage ACCELERATION is executed. A larger “accStageWait” value lengthens the duration of stage ACCELERATION. "accDutyStep" sets the increase step for the duty cycle, while “accTimeStep” sets the decrease step for the period of commutation in open loop.

```c
uint16 freerunDuty;
uint8 accStageInterval;
uint8 accStageWait;
uint8 accDutyStep;
uint8 accTimeStep;
```
uint8 accStageInterval;
uint8 accStageWait;
uint8 accDutyStep;
uint8 accTimeStep;

If the system cannot detect a valid continuous zero-crossing point in the previous stages, the startup procedure is considered a failure. The system running stage is set as “FREERUNFAILED,” and errorCode is set as “FREERUN_ERROR.”

If a continuous zero-crossing is detected within a sequence of timeout events, the system switches to position closed-loop mode, no matter which stage of the procedure is occurring. The system then waits for a specified time to enable speed closed-loop mode. This waiting time is specified by “speedCloseLoopWait.” It is a threshold for an internal counter that counts how many times position closed-loop mode is executed. A larger “speedCloseLoopWait” value lengthens the duration of position closed-loop mode.

uint8 speedCloseLoopWait;

5.3.6.3 Tuning for Different BLDC Motors
When changing the motor, some motor-related parameters or macros need modification, as listed in Table 5-1.

Table 5-1. Motor-Related Parameters for Sensorless BLDC Motor Control Example Project

<table>
<thead>
<tr>
<th>No.</th>
<th>Parameter</th>
<th>Location</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>polePairNumber</td>
<td>BLDC_Config_T</td>
<td>Pole-pair number for motor</td>
</tr>
<tr>
<td>2</td>
<td>direction</td>
<td>BLDC_Config_T</td>
<td>Desired rotation direction</td>
</tr>
<tr>
<td>3</td>
<td>NORMAL DC_VOLTAGE</td>
<td>Parameters.h</td>
<td>DC bus voltage in volts</td>
</tr>
<tr>
<td>4</td>
<td>MAX_SPEED_REF_RPM</td>
<td>Parameters.h</td>
<td>Maximum rotation speed</td>
</tr>
<tr>
<td>5</td>
<td>MIN_SPEED_REF_RPM</td>
<td>Parameters.h</td>
<td>Minimum rotation speed</td>
</tr>
<tr>
<td>6</td>
<td>START_PWM_DUTY</td>
<td>Parameters.h</td>
<td>The duty cycle of startup. Its value depends on input voltage, motor characteristic, and load status. Generally, it is tuned based on the try-observe method. The more the load, the larger the duty cycle value.</td>
</tr>
<tr>
<td>7</td>
<td>FREERUN_PWM_DUTY</td>
<td>Parameters.h</td>
<td>Duty cycle for startup stage 2</td>
</tr>
<tr>
<td>8</td>
<td>INIT_SPEED_REF_RPM</td>
<td>Parameters.h</td>
<td>Generally, it should be 15 to 25 percent of the maximum speed if no value is specified.</td>
</tr>
</tbody>
</table>

5.3.6.4 Status LED Display and Error Code
Multiple error states are defined in the BLDCController.h file as follows.

```c
typedef enum _Error_Code
{
    NO_ERROR, /* no error happens */
    ZC_CHECK_ERROR, /* zero-crossing detection failure */
    OV_ERROR, /* overvoltage happens */
    UV_ERROR, /* undervoltage happens */
    FREERUN_ERROR, /* freerun stage fails, fail to enter close loop */
    ANY_ERROR, /* for any unknown error */
    ERROR_SIZE /* variable to store count of error types */
} Error_Code_T;
```
A status LED is used to display the system status. When the motor is rotating normally, the LED is turned on. When the motor is stopped normally, the LED is turned off. When an error occurs, the status LED flashes. The number of flash times indicates the error code. For example, if the status LED flashes three times, the UV_ERROR has occurred.

### 5.4 Sensorless FOC Motor Control Example Project

#### 5.4.1 Sensorless FOC Background

##### 5.4.1.1 PMSM Introduction

PMSM is the most popular motor type in industrial, home appliance, and automotive medium- and high-end applications. As Figure 5-25 shows, PMSM has a structure similar to that of the AC induction motor. PMSM has a wound stator and permanent magnet rotors that provide sinusoidal flux distribution in the air gap, making the BEMF form a sinusoidal shape. The construction of the stator and rotor can provide lower rotor inertia and high power efficiency and reduce the motor size.

![PMSM Structure](image)

Figure 5-25. PMSM Structure

Depending on how magnets are attached to the rotor, PMSM motors can be classified into two types: surface PMSM (SPMSM) and interior PMSM (IPMSM). Figure 5-26 illustrates the differences between these two types. SPMSM mounts all magnet pieces on the surface, and IPMSM places magnets inside the rotor. SPMSM is widely used for simple manufacturing and assembling, while IPMSM optimizes performance by the specific placement of magnets. “PMSM” refers to “SPMSM” in the remainder of this guide, unless otherwise specified.

![SPMSM and IPMSM Structural Differences](image)

Figure 5-26. SPMSM and IPMSM Structural Differences

##### 5.4.1.2 PMSM Mathematical Model

A mathematical model of PMSM motors is essential for control and performance analysis. Before discussing any model, some assumptions should be set.

- PMSM winding connection is in “Y” type; any delta connections need to convert to “Y” type.
- Magnetic saturation is neglected.
- Eddy currents and hysteresis losses are negligible.

Figure 5-27 illustrates a three-phase stator reference frame, which is the basic PMSM model. In this frame, the axis of \( A, B, C \) is aligned with the direction of the PMSM stator windings; \( \Psi_r \) is the flux linkage vector of the rotor magnet. The rotor rotates at angular speed \( \omega_r \) and generates an angle \( \theta_r \) between \( \Psi_r \) and phase \( A \).
The voltage on the stator winding can be presented as

\[
\begin{bmatrix}
  u_a \\
  u_b \\
  u_c
\end{bmatrix} =
\begin{bmatrix}
  R_a & 0 & 0 \\
  0 & R_b & 0 \\
  0 & 0 & R_c
\end{bmatrix}
\begin{bmatrix}
  i_a \\
  i_b \\
  i_c
\end{bmatrix} + \rho
\begin{bmatrix}
  \psi_a \\
  \psi_b \\
  \psi_c
\end{bmatrix}
\]

Where

- \([u_a \ u_b \ u_c]^T\) Stator voltage vector
- \(\text{diag}[R_a \ R_b \ R_c]\) Stator resistance
- \([i_a \ i_b \ i_c]^T\) Stator current vector
- \(\rho\) Differential operator \(\frac{d}{dt}\)
- \([\psi_a \ \psi_b \ \psi_c]^T\) Stator flux linkages

The stator winding flux linkages can be written as the sum of the flux linkages due to their own excitation, mutual flux linkages resulting from other winding currents, and flux linkages from magnet sources of the rotor. As stator windings have 120-degree angles in mechanical space, the stator flux linkages can be expressed as follows.

\[
\begin{bmatrix}
  \psi_a \\
  \psi_b \\
  \psi_c
\end{bmatrix} =
\begin{bmatrix}
  L_{aa}(\theta_r) & M_{ab}(\theta_r) & M_{ac}(\theta_r) \\
  M_{ba}(\theta_r) & L_{bb}(\theta_r) & M_{bc}(\theta_r) \\
  M_{ca}(\theta_r) & M_{cb}(\theta_r) & L_{cc}(\theta_r)
\end{bmatrix}
\begin{bmatrix}
  i_a \\
  i_b \\
  i_c
\end{bmatrix} + \psi_f
\begin{bmatrix}
  \cos(\theta_r) \\
  \cos(\theta_r - 120^\circ) \\
  \cos(\theta_r + 120^\circ)
\end{bmatrix}
\]

Where

- \(L_{aa}, L_{bb}, L_{cc}\) Equivalence inductance of stator
- \(M_{aa}, M_{bb}, M_{cc}\) Mutual equivalence inductance of stator
- \(\psi_f\) Amplitude of rotor flux linkages

This model is high order, strongly coupled, and nonlinear. It is difficult to analyze and control torque and flux; therefore, a two-phase d-q model is developed to simplify the three-phase model. The d-q model is based on a rotating two-phase reference frame that is aligned with the rotor flux. It first converts the three-phase reference frame (a, b, c) to a two-phase stationary reference frame (α, β) using the Clarke transformation (Figure 5-28).
Figure 5-28. Reference Frame Conversion Using Clarke Transformation

The current vector $[i_a \ i_\beta]^T$ in the ($\alpha$, $\beta$) frame is

$$
\begin{bmatrix}
  i_a \\
  i_\beta
\end{bmatrix} = \frac{2}{3} \begin{bmatrix}
  1 & -1/2 & -1/2 \\
  0 & \sqrt{3}/2 & \sqrt{3}/2
\end{bmatrix} \begin{bmatrix}
  i_a \\
  i_b \\
  i_c
\end{bmatrix}
$$

For "star" type winding connections, the sum of three-phase currents is zero.

$$i_a + i_b + i_c = 0$$

Therefore, the current vector on the $\alpha$-axis and $\beta$-axis can be presented as

$$i_a = i_a$$

$$i_\beta = \frac{1}{\sqrt{3}} (i_a + 2i_b)$$

Then a Park transformation converts the ($\alpha$, $\beta$) frame to a rotating two-phase reference frame ($d$, $q$) aligned with the rotor flux (Figure 5-29). The current vectors in the ($d$, $q$) frame are

$$i_d = i_a \cos \theta + i_\beta \sin \theta$$

$$i_q = -i_a \sin \theta + i_\beta \cos \theta$$

Figure 5-29. Reference Frame Conversion Using Park Transformation

Now the voltage in the $d$-$q$ frame can be calculated by $i_d$ and $i_q$.

$$u_d = R i_d + \frac{d \psi_d}{dt} - \omega_r \psi_q$$

$$u_q = R i_q + \frac{d \psi_q}{dt} + \omega_r \psi_d$$

$$\psi_d = L_d i_d + \psi_f$$

$$\psi_q = L_q i_q$$
The torque equation is

\[ T_e = \frac{3}{2} P_n (\dot{\Psi}_d l_q - \dot{\Psi}_q l_d) \]

\[ = \frac{3}{2} P_n [\dot{\Psi}_f l_q - (L_q - L_d) i_d l_q] \]

Where

\[ P_n \quad \text{Pole-pair number of rotor} \]

Note that \( L_d \) and \( L_q \) have no relationship with electrical angle \( \theta \), and \( L_q \) is equal to \( L_d \) for SPMSM; therefore, the torque can be expressed as

\[ T_e = \frac{3}{2} P_n \dot{\Psi}_f l_q \]

Both \( P_n \) and \( \dot{\Psi}_f \) are related to motor characters, and they are not affected by motor operation. Therefore, torque is proportional only to the q-axis current \( l_q \) in the d-q model, which provides a simple method to control torque generation.

5.4.1.3 Field-Oriented Control

FOC, also called “vector control,” employs the d-q model. It is a control technique used in PMSM and AC induction motors for high-performance motor applications. It can operate smoothly over a wide speed range and is capable of fast acceleration and deceleration. It can easily control the motor torque to reduce ripple and achieve smooth rotation with lower noise and vibration.

Figure 5-30 illustrates the control block diagram for FOC. Compared to the basic d-q model, it introduces four new blocks: Speed and Position Estimation, Speed Regulator, Current PI Regulators, and Space Vector PWM (SVPWM).

Figure 5-30. Sensorless FOC Block Diagram

Speed and Position Estimation samples the feedback signal from the motor and calculates the angular speed and position of the rotor. This information is employed in the Clarke and Park transformations to convert three-phase currents to \( l_q \) and \( l_d \) in the d-q model.

Speed Regulator and Current PI Regulators employ control algorithms to ensure that rotation speed and d-q current remain close to the commanded values, which are set by the user or host system. The output of Current PI Regulators is transformed to three-phase voltages by inverse Clarke and Park transformation.

The SVPWM, also called “SVM,” is used to generate a sinusoidal current waveform to feed to the stator coils. Suppose \( VT_1 \) through \( VT_6 \) are the six power transistors that shape the output, and \( VT_1, VT_2, VT_5 \) are the upper transistors. When an upper transistor is switched on, the corresponding lower transistor is switched off.

If recording the ON state of the upper transistor as “1” and the OFF state as “0”, there are eight possible combinations of ON and OFF states. Corresponding to these different combinations are eight outputs, as shown in Table 5-2. \( u_a, u_b, u_c \) are the phase (line-to-neutral) voltages, while \( u_{ab}, u_{bc}, u_{ac} \) are the line-to-line voltages.
Table 5-2. Output Combination in Three-Phase Frame

<table>
<thead>
<tr>
<th>ON/OFF State</th>
<th>Line-to-Line Voltage (Vdc)</th>
<th>Phase Voltage (Vdc)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VT₄ VT₂ VT₅</td>
<td>uₒ u₂ u₆c</td>
<td>uₒ u₂ u₆c</td>
</tr>
<tr>
<td>1 0 0</td>
<td>1 0 −1</td>
<td>2/3 −1/3 −1/3</td>
</tr>
<tr>
<td>1 1 0</td>
<td>0 1 −1</td>
<td>1/3 1/3 −2/3</td>
</tr>
<tr>
<td>0 1 0</td>
<td>−1 1 0</td>
<td>−1/3 2/3 −1/3</td>
</tr>
<tr>
<td>0 1 1</td>
<td>−1 0 1</td>
<td>−2/3 1/3 1/3</td>
</tr>
<tr>
<td>1 0 1</td>
<td>0 −1 1</td>
<td>−1/3 −1/3 2/3</td>
</tr>
<tr>
<td>0 0 0</td>
<td>0 0 0</td>
<td>0 0 0</td>
</tr>
<tr>
<td>1 1 1</td>
<td>0 0 0</td>
<td>0 0 0</td>
</tr>
</tbody>
</table>

The eight combinations in Table 5-2 can be converted to six nonzero vectors and two zero vectors, as shown in Figure 5-31. The nonzero vectors form the axes of a hexagon, and the angle between any adjacent two nonzero vectors is 60 degrees. This divides the hexagon into six sectors: I through VI. The zero vectors are at the origin and apply zero voltage to a three-phase load. The eight vectors, called the “basic space vectors,” are denoted by U₀, U₆₀, U₁₂₀, U₁₈₀, U₂₄₀, U₃₀₀, 0₀₀₀, and 0₁₁₁.

Figure 5-31. Space Vectors

Assume Uₒᵤₜ is the desired reference voltage in the (α, β) frame. The reference voltage Uₒᵤₜ can be produced by a combination of basic space vectors using the SVPWM technique. Figure 5-32 shows an example. Uₒᵤₜ is in sector I (U₀ ~ U₆₀), and the period of PWM is T. T₁ is the respective duration for U₀ appearance; T₂ is the respective duration for U₆₀ appearance; T₀ is the duration of zero vectors.

Figure 5-32. Voltage Vector in Sector I

Then the Uₒᵤₜ can be expressed as

\[ T = T₁ + T₂ + T₀ \]

\[ Uₒᵤₜ = U₆₀ × \frac{T₂}{T} + U₀ × \frac{T₁}{T} \]

Therefore
\[ |U_{\text{out}}| \cos \theta = |U_{60}| \times \frac{T_2}{T} \times \cos \frac{\pi}{3} + |U_0| \times \frac{T_1}{T} \]

\[ |U_{\text{out}}| \sin \theta = |U_{60}| \times \frac{T_2}{T} \times \sin \frac{\pi}{3} \]

Then

\[ T_2 = mT \sin \theta \]
\[ T_1 = mT \sin \left( \frac{\pi}{3} - \theta \right) \]
\[ m = \sqrt{3} \times \frac{|U_{\text{out}}|}{U_{\text{dc}}} \]
\[ |U_{\text{out}}| = \sqrt{u_a^2 + u_\beta^2} \]

According to the ON/OFF state of the upper transistor in \( U_{60} \), \( U_a \), and zero vector, the \( U_{\text{out}} \) can be generated by changing the duty cycles of PWMs applied to the inverter.

5.4.1.4 Sensorless FOC Technique

The Park transformation requires the rotor position information, which is presented as the angle \( \theta \) between the rotor flux linkage and \( \alpha \)-axis. This is calculated by the Speed and Position Estimation block based on the motor feedback signals.

In a sensed design, the feedback signal comes from specific sensors, such as Hall sensors or optical encoders. These sensors not only increase the total cost of the motor system, but they also require maintenance, as they may fail during the motor’s lifetime. The sensorless technique removes the physical sensors and replaces them with an algorithm in a microcontroller.

The idea of the sensorless technique is to estimate position based on the BEMF due to its relationship with angle \( \theta \). The BEMF can be measured directly. However, the measurement circuitry has to handle high voltages; therefore, this technique is not encouraged.

The two-phase voltages in the \((\alpha, \beta)\) frame can be expressed as

\[ \begin{bmatrix} u_\alpha \\ u_\beta \end{bmatrix} = \begin{bmatrix} R_s + \rho L & 0 \\ 0 & R_s + \rho L \end{bmatrix} \begin{bmatrix} i_\alpha \\ i_\beta \end{bmatrix} + \begin{bmatrix} e_\alpha \\ e_\beta \end{bmatrix} \]

Where

- \( R_s \) Resistance of winding phase
- \( L \) \( L_\alpha = L_\beta = L \) for SPMWM
- \( \rho \) Differential operator \( d/dt \)
- \( \begin{bmatrix} e_\alpha \\ e_\beta \end{bmatrix} \) BEMF excited by rotor magnet

In the digital domain, the equation can be changed to

\[ \frac{i_\alpha(n+1) - i_\alpha(n)}{T_s} = \left( -\frac{R_s}{L_s} \right) i_\alpha(n) + \frac{1}{L_s} [u_\alpha(n) - e_\alpha(n)] \]

Where

- \( T_s \) Period of PWM on inverter

Solving for \( i_\alpha \) as

\[ i_\alpha(n+1) = (1 - T_s \frac{R_s}{L_s}) i_\alpha(n) + \frac{T_s}{L_s} [u_\alpha(n) - e_\alpha(n)] \]

Note that \( R_s \) and \( L_s \) are the motor characteristics, which can be measured by equipment. \( T_s \) is a constant system parameter, \( i_\alpha(n) \) is a sampling result in the last control cycle, and \( u_\alpha(n) \) is the calculation result in the last control cycle. Therefore, if \( e_\alpha(n) \) is given as \( e^*_\alpha(n) \), an estimated current value \( i^*_\alpha(n+1) \) can be obtained. The “*” here indicates it is a value estimated by algorithm and not directly measured.

Comparing \( i^*_\alpha(n+1) \) with the actual current value \( i_\alpha(n+1) \) sampled by ADC, an error between these two can be fed to adjust the given value \( e^*_\alpha(n) \) for better estimation. This process is repeated until the error between \( i^*_\alpha(n+1) \) and \( i_\alpha(n+1) \) is as small as required. Then the given value \( e^*_\alpha(n) \) represents the actual BEMF \( e_\alpha(n) \).
The $e_p(n)$ can be obtained in the same way, and the angle $\theta$ can be calculated as

$$\theta(n) = \arctan \left( \frac{-e_a(n)}{e_p(n)} \right)$$

Angular speed $\omega_r$ is calculated by accumulating $\theta$ over $m$ samples and is multiplied by speed constant $K$.

$$\omega_r = \sum_{n=1}^{m} [\theta(n) - \theta(n-1)] * K$$

Thus, the position and speed information are retrieved from the estimated BEMF.

### 5.4.2 Sensorless Foc Motor Control Example Project Overview

Figure 5-33 illustrates the block diagram of the Sensorless Foc Motor Control example project based on PSoC 4A. The input control signals to the PSoC 4 device are the following.

- **Speed command**: An analog input pin that measures the voltage across a potentiometer to set the desired speed of rotation (one analog input pin).
- **Motor current measurement**: Two analog input pins to detect the motor winding current by sensing resistors. Then the signal is routed to internal opamps to be amplified and filtered.
- **Start/Stop control**: Digital input connected to a switch to start and lock rotation of the motor (one digital input pin).

Outputs from the PSoC 4 device are power device driver signals.

- PWM signals to the high side of the MOSFET driver (three digital output pins)
- PWM signals to the low side of the MOSFET driver (three digital output pins)
- Overcurrent limit voltage set by the internal IDAC and an outside resistor

---

**Figure 5-33. Sensorless Foc Motor Control Example Project Block Diagram**
5.4.3 Control Schematic Overview

The Sensorless Foc Motor Control example project firmware was developed in PSoC Creator 3.2. Its schematic was separated into two pages according to the function. Figure 5-34 shows the PWM design in the "Sensorless FOC" page. The three TCPWM Components generate three couples of the center-aligned and complemented SVPWM signal according to the FOC algorithm.

Figure 5-34. PWM Schematic

Figure 5-35 shows the ADC schematic in the "Sensorless FOC" page. SAR ADC is triggered in every PWM cycle by the "ov" signal, and it samples for the following signals: two-phase winding currents, bus voltage, and potentiometer divider voltage. “Opamp_A” and “Opamp_B” are internal opamps to amplify and filter the motor winding currents combining the external resistors and capacitors network.

Figure 5-35. ADC Schematic
Figure 5-36 shows the “System” page. “SW2” is the external switch that starts and stops the motor. “UART_BCP” is an internal SCB Component configured as “UART,” which is responsible for sending data to the BCP while the motor is running.

5.4.4 Firmware Introduction

Figure 5-37 gives the firmware execution flow. Most of the FOC calculation is done in an ISR triggered by the PWM UN event. As there is only one UN for each PWM period, the ISR is executed per 100 µs (10-kHz PWM on the inverter), which is also the control cycle period for the PSoC 4 FOC implementation.

The FOC algorithm requires that the PWM duty cycle be updated for each control period, while other functions, such as communication with other systems, overvoltage detection, and so on do not require real-time processing. Therefore, these functions are executed in the main routine.

To create a multilayer, professional, and extensible library architecture for the Cypress motor control solution, the Sensorless Foc Motor Control example project utilizes a multilayer structure. Figure 5-38 shows the layer diagram of the example project.
A description of each layer follows.

**Hardware Abstraction Layer (HAL)**
- This layer separates the chip-related code from the motor control algorithm, which ensures the algorithm can cross multiple PSoC devices.
- Use the macro definition for operation instead of a different component name in a different user design.
- User binds the real component name to the macro definition.

**General Function Layer (GFL)**
- Q-Math (16-bit, 24-bit, 32-bit fixed-point math operation)
- Trigonometric and math function (sin, cos, arctan, sqrt, abs, and so on)
- Standard PID calculation
- General filters (FIR, 1-order IIR, 2-order IIR, median filter)
- General definition such as BOOL, FALSE, TRUE, and so on

**Basic Control Layer (BCL)**
- Fundamental control modules (Clarke/Park transformation and so on)
- Decoder (Hall effect, incremental encoder, rotary encoder, and so on)
- Other fundamental features like startup

**Advanced Control Layer (ACL)**
- Sensorless algorithm for FOC, high-frequency injection
- Other protected IPs

**User Interface Layer (UIL)**
- Firmware to support tuning GUI
- Firmware to operate IDAC for debugging
- This layer is useful for debugging, but it may be removed in the final product.
Motor Application Layer (MAL)

- General motor application functions (start motor, stop motor, speed ramp-up, speed slowdown, and so on).
- Basic fault detection (overcurrent, overvoltage, undervoltage, motor fault, and so on)

5.4.5 Running the Sensorless Foc Motor Control Example Project

5.4.5.1 Step 1 – Configure CY8CKIT-042

Select 3.3 V as the VDD power at jumper J9 on the Pioneer Kit. In this application, the USB cable is used only for burning firmware, so it can be removed from CY8CKIT-042 after programming. Figure 5-39 shows the configuration.

Figure 5-39. CY8CKIT-042 Configuration for Sensorless Foc Motor Control Example Project

5.4.5.2 Step 2 – Configure CY8CKIT-037

Configure the board via jumpers J13–J24 for the Sensorless Foc Motor Control example project (“BLDC 2-SHUNT FOC” row in Figure 5-1). Figure 5-40 shows the EVK board configured for the Sensorless Foc Motor Control example project.

Figure 5-40. CY8CKIT-037 Configuration for Sensorless Foc Motor Control Example Project

5.4.5.3 Step 3 – Plug CY8CKIT-037 into CY8CKIT-042

Plug the EVK board into the Pioneer Kit via connectors J1–J4, as shown in Figure 5-11.
5.4.5.4 Step 4 – Connect the Power Supply and Motor

Connect the BLDC motor windings to J9 and J10 on the EVK board, and then connect the 24-V power adapter to J7, as shown in Figure 5-41. When LED1 is red, it indicates power is on. If it is not glowing, the fuse F2 may be broken. Please change the F2 with the provided backup fuse.

Figure 5-41. Connect Motor and Power Supply

5.4.5.5 Step 5 – Build the Project and Program PSoC 4

Open the Sensorless Foc Motor Control example project in PSoC Creator 3.2 or later version, as shown in Figure 5-42. Choose Build > Build Sensorless Foc Motor Control to start building the project, and then choose Debug > Program to program the chip.

Figure 5-42. Open the Sensorless Foc Motor Control Example Project

CAUTION

During the debugging process, if you modify the code in the firmware, make sure that the changes do not turn on both the high-side and low-side MOSFETs.
5.4.5.6 Step 6 – Press the SW2 Button to Start Motor Rotation

Press the SW2 button to start motor rotation (refer to Figure 5-14). If the motor does not rotate and you observe LED2 blinking, it indicates that an error has occurred. If so, first check that step 1 through step 5 have executed correctly. Then press the Reset button and press the SW2 button again. If LED2 still blinks, there must be a problem in the hardware or software. You have to debug it or contact Cypress for technical support.

**CAUTION** Do not remove jumpers while the kit is powered.

5.4.6 Adapting the Example Project to another Motor

This example project can be used to control several different types of three-phase PMSM motors, and motor performance is closely related to motor parameters. So the motor-related parameters in the project firmware need to be modified according to your specific motor characteristics. The motor-related parameters are defined by a struct in Cymc_MAL.h. Table 5-3 shows the motor-related parameters.

Table 5-3. Motor-Related Parameters for Sensorless Foc Motor Control Example Project

<table>
<thead>
<tr>
<th>Variable's Name in Project</th>
<th>Structure Member</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name: motor</td>
<td>float Rs</td>
<td>motor Rs</td>
</tr>
<tr>
<td>Type: Struct MotorController</td>
<td>float Ls</td>
<td>motor Ls</td>
</tr>
<tr>
<td>Location: Cymc_MAL.h</td>
<td>uint8 Poles</td>
<td>motor Poles</td>
</tr>
<tr>
<td>Comments: motor parameters struct</td>
<td>float baseFrequency</td>
<td>base frequency</td>
</tr>
<tr>
<td></td>
<td>float Ts</td>
<td>PWM period</td>
</tr>
<tr>
<td></td>
<td>uint16 speedRPM</td>
<td>Speed in RPM format. Read only.</td>
</tr>
<tr>
<td></td>
<td>uint16 ratedSpeedRPM</td>
<td>rated speed in RPM format</td>
</tr>
<tr>
<td></td>
<td>uint8 runState</td>
<td>motor run state</td>
</tr>
<tr>
<td></td>
<td>q15_t speedRef</td>
<td>speed reference</td>
</tr>
<tr>
<td></td>
<td>q15_t vdRef</td>
<td>vd reference</td>
</tr>
<tr>
<td></td>
<td>q15_t vqRef</td>
<td>vq reference</td>
</tr>
</tbody>
</table>

Rs, Ls, Poles, baseFrequency, Ts, and ratedSpeedRPM are the motor’s parameters. The related macro definitions are in Cymc_MAL.h as follows.

```c
#define M_RS            0.8
#define M_LS            0.0012
#define M_POLES         8
#define M_TS            0.0001
#define M_BASEFREQUENCY 266.67
```

You can modify these parameters in the void Cymc_MAL_MotorInit() function in Cymc_MAL.c.

Table 5-4 shows the control-related parameters.

Table 5-4. Control-Related Parameters

<table>
<thead>
<tr>
<th>Variable's Name in Project</th>
<th>Structure Member</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name: rampUp</td>
<td>q15_t RefSpeed</td>
<td>reference speed</td>
</tr>
<tr>
<td>Type: Struct RampUp</td>
<td>q15_t delayPrescaler</td>
<td>delay prescaler</td>
</tr>
<tr>
<td>Location: Cymc_MAL.h</td>
<td>q15_t stepSpeed</td>
<td>step speed</td>
</tr>
<tr>
<td>Comments: motor parameters struct</td>
<td>q15_t output</td>
<td>output speed</td>
</tr>
<tr>
<td>Name: pidSpeed</td>
<td>q15_t ref</td>
<td>reference set point</td>
</tr>
<tr>
<td>Variable’s Name in Project</td>
<td>Structure Member</td>
<td>Comments</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Type</strong>: Struct PIController</td>
<td>q15_t fbk</td>
<td>feedback</td>
</tr>
<tr>
<td><strong>Location</strong>: Cymc_MAL.h</td>
<td>q15_t out</td>
<td>controller output</td>
</tr>
<tr>
<td><strong>Comments</strong>: PID controller for speed</td>
<td>q15_t kr</td>
<td>reference set-point weighting</td>
</tr>
<tr>
<td></td>
<td>q15_t kp</td>
<td>proportional loop gain</td>
</tr>
<tr>
<td></td>
<td>q15_t ki</td>
<td>integral gain</td>
</tr>
<tr>
<td></td>
<td>q15_t outMax</td>
<td>upper output limit</td>
</tr>
<tr>
<td></td>
<td>q15_t outMin</td>
<td>lower output limit</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name: pidId</th>
<th>q15_t ref</th>
<th>reference set-point</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong>: Struct PIController</td>
<td>q15_t fbk</td>
<td>feedback</td>
</tr>
<tr>
<td><strong>Location</strong>: Cymc_MAL.h</td>
<td>q15_t out</td>
<td>controller output</td>
</tr>
<tr>
<td><strong>Comments</strong>: PID controller for d-axis current</td>
<td>q15_t kr</td>
<td>reference set-point weighting</td>
</tr>
<tr>
<td></td>
<td>q15_t kp</td>
<td>proportional loop gain</td>
</tr>
<tr>
<td></td>
<td>q15_t ki</td>
<td>integral gain</td>
</tr>
<tr>
<td></td>
<td>q15_t outMax</td>
<td>upper output limit</td>
</tr>
<tr>
<td></td>
<td>q15_t outMin</td>
<td>lower output limit</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name: pidIq</th>
<th>q15_t ref</th>
<th>reference set-point</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong>: Struct PIController</td>
<td>q15_t fbk</td>
<td>feedback</td>
</tr>
<tr>
<td><strong>Location</strong>: Cymc_MAL.h</td>
<td>q15_t out</td>
<td>controller output</td>
</tr>
<tr>
<td><strong>Comments</strong>: PID controller for q-axis</td>
<td>q15_t kr</td>
<td>reference set-point weighting</td>
</tr>
<tr>
<td></td>
<td>q15_t kp</td>
<td>proportional loop gain</td>
</tr>
<tr>
<td></td>
<td>q15_t ki</td>
<td>integral gain</td>
</tr>
<tr>
<td></td>
<td>q15_t outMax</td>
<td>upper output limit</td>
</tr>
<tr>
<td></td>
<td>q15_t outMin</td>
<td>lower output limit</td>
</tr>
</tbody>
</table>

rampUp is used for ramping up the speed reference to the given speed.

pidSpeed is the PID controller for speed. The related macro definitions are located in Cymc_MAL.h as follows.

```c
#define PID_SPEED_KP    _FQ(0.8333)
#define PID_SPEED_KR    _FQ(1.0)
#define PID_SPEED_KI    _FQ(0.0033264)
#define PID_SPEED_OMAX  _FQ(0.55)
#define PID_SPEED_OMIN  _FQ(-0.55)
```

pidId is the PID controller for d-axis current. The related macro definitions are located in Cymc_MAL.h as follows.

```c
#define PID_ID_KP       _FQ(1.0)
#define PID_ID_KR       _FQ(1.0)
#define PID_ID_KI       _FQ(0.2)
#define PID_ID_OMAX     _FQ(0.7)
#define PID_ID_OMIN     _FQ(-0.7)
```
pidq is the PID controller for q-axis current. The related macro definitions are located in `Cymc_MAL.h` as follows.

```c
#define PID_IQ_KP     _FQ(1.0)
#define PID_IQ_KR     _FQ(1.0)
#define PID_IQ_KI     _FQ(0.2)
#define PID_IQ_OMAX   _FQ(0.95)
#define PID_IQ_OMIN   _FQ(-0.95)
```

You can modify these parameters in the `Cymc_MAL_MotorInit()` and `Cymc_MAL_MotorStart()` functions in `Cymc_MAL.c`.

### 5.5 SingleShunt Foc Motor Control Example Project

#### 5.5.1 SingleShunt Foc Background

The two-shunt sensorless Foc example project in the Sensorless Foc Motor Control Example Project gets the motor winding current and estimates the rotor position from two sensing resistors directly in series with two coil current paths. The single-shunt FOC technique uses only one sensing resistor to get the bus current and reconstruct the two-phase motor winding current. It then estimates the rotor position according to the reconstructed winding current. Compared with the two-shunt FOC technique, it saves a sensing resistor and a differential amplifier and so reduces the cost and PCB space. Figure 5-43 shows the current measurement by the single shunt.

**Figure 5-43. Single-Shunt FOC Current Measurement**

![Diagram showing current measurement by a single shunt.]

The disadvantages of single-shunt FOC are obvious. You need to reconstruct the three-phase motor winding current from the bus current, so the sinusoidal modulation pattern needs to be modified to allow the bus current to be measured. This makes the PWM signal generation algorithm more complicated than in the two-shunt sensorless Foc example project.

As Figure 5-44 shows, there are eight possible combinations of ON and OFF states of PWM. Each state has a different bus current. When the PWM state is zero vector (000 or 111), the bus current is zero. For the other six states, the following discussion uses 100 vector to explain the winding current reconstruction.

When PWMA is ON, PWMB and PWMC are OFF (100 state), and current flows from phase A into phases B and C. At this time, the bus current is `iA`, as Figure 5-44 shows.
In the same way, you can get the bus current of other PWM states. **Table 5-5** shows the relationship between the bus current and the PWM state.

**Table 5-5. Relationship Between Bus Current and PWM State**

<table>
<thead>
<tr>
<th>1H</th>
<th>1L</th>
<th>2H</th>
<th>2L</th>
<th>3H</th>
<th>3L</th>
<th>iBus</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>iA</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>IB</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>IC</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>-iA</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>-IB</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>-IC</td>
</tr>
</tbody>
</table>

So, if you sample bus current twice in one PWM period in a different PWM state, you can get two-phase currents. Then you can reconstruct the third one.

### 5.5.2 SingleShunt Foc Motor Control Example Project Overview

**Figure 5-45** illustrates the block diagram of the SingleShunt Foc Motor Control example project based on PSoC 4A. The input control signals to the PSoC 4 device are the following.

- **Speed command**: Analog input pin that measures the voltage across a potentiometer to set the desired speed of rotation (one analog input pin)
- **Motor current detection**: Analog input pin to detect and cut off power to the device driver to protect the motor when an overcurrent condition is detected (see *Control Schematic Overview*)
- **Vbus**: Analog input pin that routes bus voltage to the SAR ADC to monitor the bus voltage
- **Start/stop control**: Digital input connected to a switch to start and stop the motor rotation (one digital input pin)

Outputs from the PSoC 4 device are power device driver signals.

- PWM signals to the high side of the MOSFET driver (three digital output pins)
- PWM signals to the low side of the MOSFET driver (three digital output pins)
- Overcurrent limit voltage set by the internal IDAC and an outside resistor
5.5.3 Control Schematic Overview

The SingleShunt Foc Motor Control example project firmware was developed in PSoC Creator 3.2. Its schematic was separated into two pages according to function. Figure 5-46 shows the “PWM Drive” schematic in the “FOC” page. The three TCPWM Components generate three couples of the center-aligned and complemented SVPWM signal according to the FOC algorithm.

By comparing Figure 5-47 with Figure 5-34, you can see that the PWM duty cycle update and ADC trigger mechanism are different than in the two-shunt sensorless FOC because the current sensing and reconstructing method has been changed in the single-shunt sensorless FOC.
Figure 5-47 shows the ADC trigger timing. To avoid impacting the current pulse when the PWM state changes, ADC sampling is triggered in the middle of two PWM states. So the schematic shows the use of a PWM underflow signal ("un") as a trigger source and then the use of a timer ("ADC_Timer") to create a delay to ensure that ADC is triggered in the middle of $T_1$ and $T_2$. The compare value of "ADC_Timer" is updated in real time while the motor is running. In the PWM OV interrupt ISR, the ADC trigger delay should be set as $T_1/2$. Then after ADC is triggered, the ADC trigger delay should be set as $T_2/2$ in the ADC eoc interrupt ISR.

So, to change the compare value twice in one PWM period, you need two TC events. Then the PWM switch signal is triggered by "PWM_UPDATE" on both the OV and UN events. The PWM compare value will be updated twice in one period. The PWM ISR should also be triggered twice on the OV and UN events).

Figure 5-47. ADC Trigger Timing

![Diagram](image)

Figure 5-48 shows the "Phase Current Sampling" schematic in the "FOC" page. SAR ADC is triggered twice in every PWM cycle by the "ov" and "cc" signals, and it samples three signals: bus current, bus voltage, and potentiometer divider voltage. "Opamp_A" is internal opamp to amplify and filter the bus current combining the external resistors and capacitors network.

Figure 5-48. Phase Current Sampling Schematic

![Diagram](image)

Figure 5-49 shows the "Overcurrent Protection" schematic. The bus current is measured by an external opamp and routed to the positive terminal of the internal low-power comparator "LPComp_IbusPt." The overcurrent threshold is set by an internal IDAC, "IDAC_IbusPt," and routed to the negative terminal of "LPComp_IbusPt." When an overcurrent condition happens, "LPComp_IbusPt" will generate an interrupt to disable the PWM output.

Figure 5-49. Overcurrent Protection Schematic

![Diagram](image)
5.5.4 Firmware Introduction

Except for the motor current sensing and reconstruction mechanism introduced in Control Schematic Overview, the control firmware is similar to the Sensorless Foc Motor Control example project. Refer to Firmware Introduction to learn about the firmware of the SingleShunt Foc Motor Control example project.

5.5.5 Running the SingleShunt Foc Motor Control Example Project

5.5.5.1 Step 1 – Configure CY8CKIT-042

Select 3.3 V as the VDD power at jumper J9 on the Pioneer Kit. In this application, the USB cable is used only for burning firmware, so it can be removed from CY8CKIT-042 after programming. Figure 5-39 shows the CY8CKIT-042 configuration.

5.5.5.2 Step 2 – Configure CY8CKIT-037

Configure the board via jumpers J13–J24 for the SingleShunt Foc Motor Control example project (“BLDC 1-SHUNT FOC” row in Figure 5-1). Figure 5-50 shows the EVK board configured for the SingleShunt Foc Motor Control example project.

5.5.5.3 Step 3 – Plug CY8CKIT-037 into CY8CKIT-042

Plug the EVK board into the Pioneer Kit via connectors J1–J4, as shown in Figure 5-11.

5.5.5.4 Step 4 – Connect the Power Supply and Motor

Connect the BLDC motor windings to J9 and J10 on the EVK board, and then connect the 24-V power adapter to J7, as shown in Figure 5-41. When LED1 is red, it indicates power is on. If it is not glowing, the fuse F2 may be broken. Please change the F2 with the provided backup fuse.

5.5.5.5 Step 5 – Build the Project and Program PSoC 4

Open the SingleShunt Foc Motor Control example project in PSoC Creator 3.2 or later version, as shown in Figure 5-51. Choose Build > Build SingleShunt Foc Motor Control to start building the project, and then choose Debug > Program to program the chip.
5.5.5.6 Step 6 – Press the SW2 Button to Start Motor Rotation

Press the SW2 button to start motor rotation (refer to Figure 5-14). If the motor does not rotate and you observe LED2 blinking, it indicates that an error has occurred. If so, first check that step 1 through step 5 have executed correctly. Then press the Reset button and press the SW2 button again. If LED2 still blinks, there must be a problem in the hardware or software. You have to debug it or contact Cypress for technical support.

CAUTION Do not remove jumpers while the kit is powered.

5.5.6 Adapting the Example Project to another Motor
Refer to Adapting the Example Project to another Motor.

5.6 Stepper Motor Control Example Project

CY8CKIT-037 does not provide a stepper motor in the kit package. However, the kit does support a stepper motor controlled with microstep from hardware and firmware. A Stepper Motor Control example project is included in the kit installation directory. To demonstrate this project, you need to connect your stepper motor to the CY8CKIT-037 kit. The only requirement for the motor is that the power range should meet the kit spec.

5.6.1 Stepper Motor Background

The stepper motor is an electromechanical device that converts electrical pulses into discrete mechanical movement. It can achieve accurate positioning and potential rotation speed control without a feedback sensor. So it is ideally suited for many measurement and control applications where positional accuracy is important and cost is very low.

The most frequently used stepper motor is the hybrid stepper motor. It has smaller steps, greater torque, and greater maximum speeds than a variable reluctance and permanent magnet stepper motor. Figure 5-52 shows a sectional view of the hybrid stepper motor. Both the rotor and stator have teeth, providing a smaller magnetic circuit resistance in some rotor positions, which improves static and dynamic torque.
Stepper motors have several operational modes, such as full-step mode, half-step mode, and microstep mode. Each mode controls stepper motor phases in different ways. The full-step and half-step modes have obvious torque rippling and resonance. Microstep mode changes the current by small steps that split each step into microsteps. When two phases are turned on and the current on each phase is not equal, the current phase ratio determines the rotor position. Changing the ratio produces a number of microsteps inside each full step.

Fractional steps are created by scaling torque contributions between windings. Because torque is proportional to the magnetic flux that is proportional to the current in the winding, the rotor’s position can be controlled by controlling the current flowing in each winding. To create smooth microsteps between full steps, the current is varied sinusoidally with a 90-degree phase shift between the two windings, as shown in Figure 5-53.

The current is scaled by controlling the RMS current using a current-mode buck converter, commonly called a “chopper drive” when used with stepper motors. The phase current is converted into a voltage using a sensing resistor in each phase ground path. This voltage is routed to a comparator, which disables the output whenever the phase current rises above a reference. The comparator reference is provided by an IDAC. By changing the IDAC-supplied current limit for each microstep, the total motor torque remains approximately constant for each step of the sinusoidal current waveform.

5.6.2 Stepper Motor Control Example Project Overview

Figure 5-54 illustrates the block diagram of the Stepper Motor Control example project based on PSoC 4A. The input control signals to the PSoC 4 device are as follows.

- **Speed command**: An analog input pin that measures the voltage across a potentiometer to set the desired speed of rotation (one analog input pin).
- **Motor current detection**: Two analog input pins to detect the motor winding current by sensing resistors. Then the signal is routed to internal opamps to be amplified.
- **PWM kill**: Two digital input pins that are the output of external comparators. A high level of this signal will stop internal PWM output and force the winding current to decrease to the current reference set by the IDAC.
- **Start/lock control**: A digital input connected to a switch to start and lock rotation of the motor (one digital input pin).
Outputs from the PSoC 4 device are power device driver signals.

- PWM signals to the high side of the MOSFET driver (four digital output pins).
- PWM signals to the low side of the MOSFET driver (four digital output pins).
- A winding current signal amplified by internal opamps. The signal is routed to positive external comparators and is compared with the current reference set by the IDAC to construct the winding current chopper circuit.
- The sinusoidal current reference voltage set by the internal IDAC and outside resistors.

Figure 5-54. Stepper Motor Control Example Project Block Diagram

5.6.3 Control Schematic Overview

The Stepper Motor Control example project firmware was developed in PSoC Creator 3.2. Its schematic was separated into four pages according to function. Figure 5-55 shows the “PWM and Commutation” page. When the motor phase current is more than the sinusoidal reference current level, the chopper circuit will output a high level. This high level closes the PWM output and synchronizes the real motor phase current with the sinusoidal reference current level. “Control_Reg_1” indicates the current stage of the stepper motor. It is dynamically modified by firmware to commutate two phase windings independently through “LUT_A” and “LUT_B.”
Figure 5-55. PWM and Commutation Schematic

Figure 5-56 shows the “Current Chopping” page. Internal IDACs generate the sinusoidal reference, employing the internal opamps circuit sensing, and amplify the winding current. Then the output of the opamps circuit is compared with the sinusoidal reference current level for each phase in every microstep by external comparators. When the motor phase current is more than the sinusoidal reference current level, the comparator will output a high level.

Figure 5-56. Current Chopping Schematic

Figure 5-57 shows the “ADC, Button and Microstep Timer” page. “Timer_1” sets the period of the microsteps. Its overflow event triggers an interrupt, and winding commutating and sinusoidal current reference value updating are executed in its ISR. “ADC_SAR_Seq_1” is the SAR ADC to detect and measure bus voltage and potentiometer voltage.

Figure 5-57. ADC, Button and Microstep Timer Schematic
5.6.4 Firmware Introduction

Figure 5-58 shows the flow chart of the main loop function. The program first initializes and configures the internal resources of PSoC 4, and then the main loop detects the user’s start-stop command and RPM reference.

**Figure 5-58. Main Loop Function Flow Chart**

The microstep drive algorithm is processed in the timer overflow ISR in which the microstep length was set. Figure 5-59 shows the flow chart of the timer overflow ISR.

**Figure 5-59. Timer Overflow ISR Flow Chart**

5.6.5 Running the Stepper Motor Control Example Project

5.6.5.1 Step 1 – Configure CY8CKIT-042

Select 3.3 V as VDD at jumper J9 on the Pioneer Kit. In this application, the USB cable is used only for burning firmware, so it can be removed from CY8CKIT-042 after programming. Figure 5-39 shows the CY8CKIT-042 configuration.
5.6.5.2 Step 2 – Configure CY8CKIT-037

Configure the board via jumpers J13–J24 for the Stepper Motor Control example project ("STEPPER" row in Figure 5-1). Figure 5-60 shows the EVK board configured for the Stepper Motor Control example project.

Figure 5-60. CY8CKIT-037 Configuration for Stepper Motor Control Example Project

5.6.5.3 Step 3 – Plug CY8CKIT-037 into CY8CKIT-042

Plug the EVK board into the Pioneer Kit via connectors J1–J4, as shown in Figure 5-11.

5.6.5.4 Step 4 – Connect the Power Supply and Motor

Connect the stepper motor windings to J9 and J10 on the EVK board, as shown in Figure 5-61. The wire sequence and color for the motor windings should be exactly as shown in Figure 5-61. Refer to Motor Winding Connectors for instructions. Then connect the 24-V adapter to J7. When LED1 is red, it indicates power is on. If it is not glowing, the fuse F2 may be broken. Please change the F2 with the provided backup fuse.

CAUTION

Note: The CY8CKIT-037 PSoC 4 Motor Control EVK package does not include a stepper motor. Cypress recommends that you use a 42-mm (diameter or side length) stepper motor: 42BYGH403AA (with 1.8-degree step angle and 1.65-A phase current). You can also find a stepper motor from other manufacturers with the same size and electrical parameters.
5.6.5.5 Step 5 – Build the Project and Program PSoC 4

Open the Stepper Motor Control example project in PSoC Creator 3.2 or later version, as shown in Figure 5-62. Choose **Build > Build Stepper Motor Control** to start building the project, and then choose **Debug > Program** to program the chip.

**CAUTION**

During the debugging process, if you modify the code in the firmware, make sure that the changes do not turn on both the high-side and low-side MOSFETs.
5.6.5.6 Step 6 – Press the SW2 Button to Start Motor Rotation

Press the SW2 button to start motor rotation (refer to Figure 5-14). If the motor does not rotate and you observe LED2 blinking, it indicates that an error has occurred. If so, first check that step 1 through step 5 have executed correctly. Then press the Reset button and press the SW2 button again. If LED2 still blinks, there must be a problem in the hardware or software. You have to debug it or contact Cypress for technical support.

**CAUTION** Do not remove jumpers while the kit is powered.

5.6.6 Adapting the Example Project to another Motor

This example project can be used to control two phases of the HB (hybrid) stepper motor with microstep algorithm. So you need to modify the motor-related parameters in the project firmware according to your specific motor characteristics. You can also modify parameters related to function, like microstep numbers, RPM, and current level, according to your requirements. The main parameters are defined by a struct in UI_paras.h as follows.

```c
typedef struct
{
    uint8 dir;             /*Direction*/
    uint8 microStepPace;   /*For Stepper Motor*/
}UI_DATA;
```

The real struct variable is defined in main.c.

```c
UI_DATA UI_Data;
```

This struct variable is initialized in main.c by a function as follows.

```c
void MotorInit(void)
{
    Control_Start_Write(0);
    UI_Cmd.run = FALSE;
    UI_Data.microStepPace = 128; /* Set the number of micro-step pace:
                          microstep number = 128 /
                          UI_Data.microStepPace */
    UI_Data.dir = CCW;         /* Set rotating direction of motor */
}
```

This function initializes the parameters before the motor begins running. The initializing value is dedicated for the motor shipped from Cypress in the kit package. If you want to use your own motor and have different functional requirements like microstep numbers or direction, change the initializing value in this function.

**Note:** The number of microsteps is equal to “128/UI_Data.microStepPace.” So, if you set UI_Data.microStepPace=128, there is only one microstep, which means no microstep pace. So the stepper motor generates high mechanical vibration, torque ripple, and noise and may stop abruptly at some mechanical resonance points when the potentiometer is varied. So it is recommended that you set “UI_Data.microStepPace=1, 2, 4, 8, 16, or 32” to enable the microstep algorithm to make the motor run more stably and smoothly.

5.7 Bridge Control Panel Monitor Tool Guide

During the motor control debugging process, you cannot use the step debug because it prevents the CPU from running at breakpoint, which leads to blockage of the motor rotation and generates a very high current that burns the motor windings. Therefore, you need to use the real-time debugging tool to monitor the status of the running motor.

The BCP is a very useful and convenient real-time debugging tool provided by Cypress to monitor the motor state in the debugging process. This section introduces how to configure and use the BCP in real-time debugging for the motor control application.
5.7.1 BCP Monitoring Overview

Figure 5-63 shows the system structure of real-time debugging for the motor control application. The controller board (CY8CKIT-042) works as a lower terminal, and the BCP terminal on the PC works as an upper terminal. CY8CKIT-042 sends real-time motor state data through PSoC 4 dedicated UART pins (P4.0 and P4.1), and then data is pushed into the USB-to-UART bridge controller (CY7C65213) on the driver board (CY8CKIT-037). CY7C65213 repackages the data and sends it to the upper terminal through the USB cable, so you can see the curve or chart of the real-time motor state data.

Figure 5-63. Real-Time Debugging Structure

5.7.2 Installing the Driver for CY7C65213 USB-to-UART Bridge Controller

The first step in monitoring data on the BCP is to set up the hardware and install the driver program for the USB-to-UART bridge controller (CY7C65213) on CY8CKIT-037.

Connect the USB cable to CY8CKIT-037 at connector J11. Then configure the hardware for the Sensored BLDC Motor Control example project following step1 to step 5 in section 5.2.5. Figure 5-64 shows the hardware setup.

Figure 5-64. Hardware Setup for BCP

Connect the other end of J11 to your PC. The PC operating system (Windows 7 in this document) will automatically recognize the CY7C65213 USB-to-UART bridge controller and search the driver program for it, as shown in Figure 5-65.
When the operating system gets the driver program, it will automatically install it for CY7C65213. Figure 5-66 shows the information window that indicates that the driver program installation for the CY7C65213 USB-to-UART Bridge Controller is finished.

**CAUTION**

Do not press switch SW2 on the CY8CKIT-037 board during the installation process because the controller board (CY8CKIT-042) is unable to send any data to the USB-to-UART Bridge Controller (CY7C65213) during the installation process. Otherwise, the BCP will not work after the installation. All the example projects included in the kit send data only after the motor is started by pressing the start/stop switch, SW2.
5.7.3 Upper Terminal Configuration Guide

Each example project contains the lower terminal firmware to send real-time data and attaches two upper terminal configuration files, .ini and .iic.

This section uses the Sensored BLDC Motor Control example project as an example. Other example projects are similar.

Enter the BCP software interface, and choose Chart > Variable Settings to open the Variable Settings window, as Figure 5-67 shows.

Then click the Load button to import the variables.ini file into the Sensored BLDC Motor Control example project, as Figure 5-68 shows. Click the OK button to finish.

Figure 5-67. Variable Settings Window

Figure 5-68. Import variables.ini File
You also need to set the baud of BCP communication. Enter the BCP software interface, and choose **Tools > Protocol Configuration** to open the **Protocol Configuration** window, as Figure 5-69 shows. The recommended baud setting is 115,200 bps.

![Figure 5-69. Baud (bps) Settings Window](image)

Choose **File > Open File** to import the **Sensored BLDC Control.iic** configuration file into the Sensored BLDC Motor Control example project, as Figure 5-70 shows. Click the highlighted button to start monitoring data defined by the command in the **Editor** and **Variable Settings** windows.

The **Editor** window shows the BCP monitor 2 variables as a default. “SpeedCur” shows the real-time motor speed, and “SpeedRef” shows the reference motor speed. You can change or add monitoring variables by changing the command statement in the **Editor** window and keeping the **Variable Settings** window updated synchronously.

![Figure 5-70. Bridge Control Panel Editor](image)

The command structure consists of four parts: start symbol “Rx8”, header, body, and tail as follows.

```
Rx8 [H=<byte0> <byte1> ... <byteN>] <byte0> <byte1> ... <byteK> [T=<byte0> <byte1> ... <byteM>]
```

Where “Rx8” is a start symbol that indicates the beginning of the RX8 command.
Example Projects

[H=<byte0> <byte1> ... <byteN>] is a header with a list of bytes. It is intended for synchronization of the BCP to an asynchronous input stream. The header part is optional. It can be present or absent in the script. But if it is absent, then the tail also should be absent. Otherwise, the ScriptEngine syntax analyzer will inform you about a syntax error and mark in red the incorrect part of the command.

<byte0> <byte1> ... <byteK> is a body list of bytes. It is a useful packet load that is received by the host and shown in the Log and Chart subsystems, depending on the variables configuration in the command. The body is a mandatory part of the command.

[T=<byte0> <byte1> ... <byteM>] is a tail with a list of bytes. It indicates the end of the RX8 command. The tail is an optional part of the command. The RX8 command can be present in the BCP script editor analyzer in three ways:

1) Without the header and tail, with only the body. In this scenario, the host does not synchronize with a stream of bytes. It simply prints bytes received from the MiniProg3 to the Log and on the Chart if variables were configured in the script, as shown in the following example.

RX8 X X @1Var1 @0Var1 X @3Var2 @2Var2 @1Var2 @0Var2 X X

2) With the header and body, but without the tail. In this scenario, the host synchronizes with a stream of bytes, finding header bytes in the stream, as shown in the following example.

RX8 [H = 0A 0E 0C] X X @1Var1 @0Var1 X @3Var2 @2Var2 @1Var2 @0Var2 X X

3) With the header, body, and tail. In this scenario, the host synchronizes with a stream of bytes, finding header, body, and tail bytes in the stream, as shown in the following example.

RX8 [H = 0A 0E 0C] X X @1Var1 @0Var1 X @3Var2 @2Var2 @1Var2 @0Var2 X X [T = 00 FF FF]

All five example projects use this command format: H = 0x55 and T = 0xAA. Variables are 16 bits and always in "MSB-LSB" format.

You can define your own commands by following these rules.

Keep the default configuration. Press SW2 on CY8CKIT-037 to start the motor. You can see the real-time data in the Chart window, as Figure 5-71 shows. You can use a tachometer to measure the motor speed and check it on the BCP display.

Figure 5-71. BCP Data Display for Sensored BLDC Motor Control Example Project

Note: Before you complete all the configuration steps in this section (from Figure 5-67 to Figure 5-70), ensure that switch SW2 on CY8CKIT-037 is not pressed. If you press it, you will not see data display on the BCP Chart window. However, if you do press SW2, press SW1 on CY8CKIT-037 to reset the motor, and then complete all the configuration steps shown in Figure 5-67 to Figure 5-70. You can then press SW2 to start the motor and observe the data on the BCP Chart window.

If you want to run the motor and monitor data for a long time (more than 8 minutes), the BCP can display only the original 81920 counts (about 7 minutes at 115,200 bps), as Figure 5-72 shows. The later data no longer appears because the
BCP puts all the received data for display in limited stack memory. So if the stack memory is full, the BCP cannot receive and display new data. If you want to monitor the real-time data for a long time, reconfigure the BCP to make it display only the latest data, not all the data from the motor or BCP start.

Figure 5-72. Maximum Data Counts on BCP Monitoring

Choose **Chart > Variable Settings** to open the **Variable Settings** window. Then select the “AxisX is a time” option and write a number (minimum: 1, maximum: 500000, unit: ms) into the **Scroll** text box to define the latest time length to make the BCP display data, as Figure 5-73 shows. Then the stack memory will never be full, and the BCP can always show the latest data of the defined time length.

Figure 5-73. BCP Reconfiguration
5.7.4 Lower Terminal Configuration Guide

While the motor is running, MCU CY8C4245 on the controller board gets all motor state parameters and is responsible for sending them to the BCP upper terminal. Figure 5-74 shows the Serial Communication Block (SCB) Component and configuration window. It sends motor state data through two dedicated UART pins (P4.0 and P4.1). It is configured as “UART.”

Data is sent by function BCPPoll(), located in the main control loop of the firmware. The function code follows.

```c
void BCPoll()
{
    uint8 index = 0;

    if(UART_BCP_SpiUartGetTxBufferSize())
        return;

    /* package header */
    bcpTxBuffer[index++] = 0x55;

    /* construct BCP data package with speed value, MSB first */

    /* current measured speed */
    bcpTxBuffer[index++] = (uint8)((UI_Data.speedRpm & 0xFF00) >> 8);
    bcpTxBuffer[index++] = (uint8)(UI_Data.speedRpm & 0x00FF);

    /* speed reference */
    bcpTxBuffer[index++] = (uint8)((UI_Data.speedRpmRef & 0xFF00) >> 8);
    bcpTxBuffer[index++] = (uint8)(UI_Data.speedRpmRef & 0x00FF);

    /* package tail */
    bcpTxBuffer[index++] = 0xAA;

    UART_BCP_SpiUartPutArray(bcpTxBuffer, index);
}
```
This function sends two motor state variables: `UI_Data.speedRpm` and `UI_Data.speedRpmRef`. You can modify the variable name and add variables by copying the highlighted code and then changing the variable name from `UI_Data.speedRpm` to whatever you want.

### 5.7.5 Reading the Motor Speed Using BCP Commands

The BCP commands are not functional if the tool is invoked after the motor starts rotating.

To see the proper motor rotation status or RPM readings, follow these steps.

1. Connect and configure CY8CKIT-037 on the CY8CKIT-042 Pioneer Kit per the Sensored BLDC project. (See Section 5.2.5)
2. Program the HEX file.
3. Connect a USB cable at the J11 port of CY8CKIT-037 to enable the motor speed to be viewed in the BCP. (Wait until driver enumeration is complete.)
4. Open the BCP and import the UART commands related to the Sensored BLDC project. Refer section 5.7.3.
5. Select the appropriate COM port related to USB-to-UART on CY8CKIT-037 (example: COM17 in Figure 5-70. Bridge Control Panel Editor).
6. Move the cursor to the end of the BCP command “RX8 [h=55] @1speedCur @0speedCur @1speedRef @0speedRef [t=AA]” in the Command window, and press Enter to execute the BCP command once. Then click the Repeat button to repeat the command execution. (If this operation is missing, an error message window pops up as shown in Figure 5-75)

   ![Error Message](image)

   **Figure 5-75. Error Message that Appears when Step 6 is Missed while Configuring BCP**

7. Press button SW2 on CY8CKIT-037 to start the BLDC motor rotation.
8. Observe the motor speed on the BCP Editor window (see Figure 5-76) and in Chart Window (see Figure 5-77).
Figure 5-76. Motor Speed in Editor Window

Figure 5-77. Motor Speed in Chart Window
A.1 Board Schematics
A.2 Board Layout

Top Layer
Bottom Layer
## A.3 Bill of Materials

<table>
<thead>
<tr>
<th>Item</th>
<th>Qty</th>
<th>Reference</th>
<th>Description</th>
<th>Manufacturer</th>
<th>Mfr Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>C1, C2</td>
<td>CAP CER 1UF 100V 10% X7R 1206</td>
<td>TDK Corporation</td>
<td>C3216X7R2A105K160AA</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>C3</td>
<td>CAP CER 8200PF 50V 10% NP0 0603</td>
<td>TDK Corporation</td>
<td>C1608C0G1H822K080AA</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>C4, C43</td>
<td>CAP CER 1UF 50V 10% X7R 0603</td>
<td>Taiyo Yuden</td>
<td>UMK107AB7105KA-T</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>C5</td>
<td>CAP CER 1800PF 50V 10% NP0 0603</td>
<td>TDK Corporation</td>
<td>C1608C0G1H182K080AA</td>
</tr>
<tr>
<td>5</td>
<td>1</td>
<td>C6</td>
<td>CAP CER 0.022UF 50V 10% X8R 0603</td>
<td>TDK Corporation</td>
<td>C1608X8R1H223K080AA</td>
</tr>
<tr>
<td>6</td>
<td>1</td>
<td>C7</td>
<td>CAP CER 2700PF 50V 10% NP0 0603</td>
<td>TDK Corporation</td>
<td>C1608C0G1H272K080AA</td>
</tr>
<tr>
<td>7</td>
<td>2</td>
<td>C8, C47</td>
<td>CAP CER 1000PF 50V 10% X7R 0603</td>
<td>TDK Corporation</td>
<td>CGA3E2X7R1H102K080AA</td>
</tr>
<tr>
<td>8</td>
<td>1</td>
<td>C9</td>
<td>CAP ALUM 22UF 35V 20% SMD</td>
<td>Panasonic Electronic Components</td>
<td>EEE-FK1V220R</td>
</tr>
<tr>
<td>9</td>
<td>2</td>
<td>C10,C26</td>
<td>CAP CER 0.1UF 50V 10% X7R 0603</td>
<td>TDK Corporation</td>
<td>C1608X7R1H104K080AA</td>
</tr>
<tr>
<td>10</td>
<td>1</td>
<td>C11</td>
<td>CAP ALUM 330UF 100V 20% RADIAL</td>
<td>Nichicon</td>
<td>URS1J331MHD1TO</td>
</tr>
<tr>
<td>11</td>
<td>1</td>
<td>C12</td>
<td>CAP CER 0.1UF 100V 10% X7S 0603</td>
<td>TDK Corporation</td>
<td>CGA3E3X7S2A104K080AB</td>
</tr>
<tr>
<td>12</td>
<td>4</td>
<td>C16,C17,C18,C19</td>
<td>CAP CER 10UF 50V 10% X5R 1206</td>
<td>TDK Corporation</td>
<td>C3216X5R1H106K160AB</td>
</tr>
<tr>
<td>13</td>
<td>7</td>
<td>C20, C21, C22, C23, C24,C25,C29</td>
<td>CAP CER 100PF 50V 10% CH 0603</td>
<td>TDK Corporation</td>
<td>C1608CH1H101K080AA</td>
</tr>
<tr>
<td>14</td>
<td>6</td>
<td>C35, C36, C37, C38, C39, C40</td>
<td>CAP CER 330PF 50V 10% NP0 0603</td>
<td>TDK Corporation</td>
<td>C1608C0G1H331K080AA</td>
</tr>
<tr>
<td>15</td>
<td>3</td>
<td>C44,C46,C48</td>
<td>CAP CER 0.1UF 16V 10% X7R 0402</td>
<td>TDK Corporation</td>
<td>C1005X7R1C104K050BC</td>
</tr>
<tr>
<td>16</td>
<td>1</td>
<td>C45</td>
<td>CAP CER 1UF 16V 10% X5R 0402</td>
<td>TDK Corporation</td>
<td>C1005X5R1C105K050BC</td>
</tr>
<tr>
<td>17</td>
<td>1</td>
<td>D1</td>
<td>DIODE SCHOTTKY 100V 3A SMA</td>
<td>Micro Commercial Co</td>
<td>SK310A-TP</td>
</tr>
<tr>
<td>18</td>
<td>1</td>
<td>D2</td>
<td>DIODE SCHOTTKY 60V 7.5A DPAK</td>
<td>STMicroelectronics</td>
<td>STPS15L60CB-TR</td>
</tr>
<tr>
<td>19</td>
<td>4</td>
<td>D3, D4, D5, D6</td>
<td>DIODE FAST REC 50V 1A SMA</td>
<td>Micro Commercial</td>
<td>US1A-TP</td>
</tr>
</tbody>
</table>
## Appendix A: Board Schematics, Board Layout, and BOM

<table>
<thead>
<tr>
<th>Item</th>
<th>Qty</th>
<th>Reference</th>
<th>Description</th>
<th>Manufacturer</th>
<th>Mfr Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>3</td>
<td>D10,D11,D12</td>
<td>DIO, SUPPRESSOR ESD 5VDC 0603 SMD</td>
<td>Bourns Inc</td>
<td>CG0603MLC-05LE</td>
</tr>
<tr>
<td>21</td>
<td>1</td>
<td>F2</td>
<td>FUSE BRD MNT 2.5A 125VAC/VDC SMD</td>
<td>Littelfuse Inc</td>
<td>015402 5DRT</td>
</tr>
<tr>
<td>22</td>
<td>2</td>
<td>J1,J4</td>
<td>2.54mm PITCH SINGLE ROW 8POS HEADER, 13mm MATING LENGTH</td>
<td>PROTECTRON</td>
<td>P9101-08-D32-1</td>
</tr>
<tr>
<td>23</td>
<td>1</td>
<td>J2</td>
<td>2.54mm PITCH SINGLE ROW 18POS HEADER, 13mm MATING LENGTH</td>
<td>PROTECTRON</td>
<td>P9103-18-D32-1</td>
</tr>
<tr>
<td>24</td>
<td>1</td>
<td>J3</td>
<td>2.54mm PITCH SINGLE ROW 10POS HEADER, 13mm MATING LENGTH</td>
<td>PROTECTRON</td>
<td>P9101-10-D32-1</td>
</tr>
<tr>
<td>25</td>
<td>1</td>
<td>J7</td>
<td>CONN, JACK, POWER, 2.1mm, MALE, 3PIN, PCB RA, TH</td>
<td>CUI Inc</td>
<td>PJ-102A</td>
</tr>
<tr>
<td>26</td>
<td>1</td>
<td>J8</td>
<td>BLACK COLOUR, TERM BLOCK 2POS SIDE ENT 3.81MM</td>
<td>TE Connectivity</td>
<td>1776113-2</td>
</tr>
<tr>
<td>27</td>
<td>2</td>
<td>J9,J10</td>
<td>GREEN COLOUR, TERM BLOCK 2POS 3.81MM PCB HORIZ</td>
<td>FCI</td>
<td>20020327-D021B01LF</td>
</tr>
<tr>
<td>28</td>
<td>1</td>
<td>J11</td>
<td>CONN, MINI USB, RCPT R/A, DIP, B TYPE</td>
<td>TE Connectivity</td>
<td>1734510-1</td>
</tr>
<tr>
<td>29</td>
<td>1</td>
<td>J12</td>
<td>ConWTB Wire to Board Connector 2.50mm pitch, &quot;J&quot; Type Vertical Male Shrouded Header, 5 pin</td>
<td>Wurth Elektronik</td>
<td>688 005 116 22</td>
</tr>
<tr>
<td>30</td>
<td>11</td>
<td>J13, J14, J15, J16, J17, J18, 20, J21, J22, J23, J24</td>
<td>CONN, HEADER, VERT, SGL, 3POS, GOLD</td>
<td>PROTECTRON</td>
<td>P9101-03-12-1</td>
</tr>
<tr>
<td>31</td>
<td>1</td>
<td>J19</td>
<td>CONN, HEADER, FEMALE, 3POS, .1&quot;, TIN, TH</td>
<td>Sullins Connector Solutions</td>
<td>PPTC031LFBN-RC</td>
</tr>
<tr>
<td>32</td>
<td>1</td>
<td>LED1</td>
<td>LED RED CLEAR 0603 SMD</td>
<td>Lite-On Inc</td>
<td>LTST-C190CKT</td>
</tr>
<tr>
<td>33</td>
<td>1</td>
<td>LED2</td>
<td>LED GREEN CLEAR THIN 0603 SMD</td>
<td>Lite-On Inc</td>
<td>LTST-C190GKT</td>
</tr>
<tr>
<td>34</td>
<td>1</td>
<td>L1</td>
<td>FERRITE CHIP 600 OHM 1500MA 1206</td>
<td>Murata Electronics North America</td>
<td>BLM31PG601SN1L</td>
</tr>
<tr>
<td>35</td>
<td>1</td>
<td>L2</td>
<td>INDUCTOR POWER 150UH 20% SMD</td>
<td>TDK Corporation</td>
<td>CLF6045T-151M-H</td>
</tr>
<tr>
<td>36</td>
<td>2</td>
<td>L3,L4</td>
<td>IND, FERRITE, 220 OHM, 2A, 25%, 0805</td>
<td>Murata Electronics North America</td>
<td>BLM21PG221SN1D</td>
</tr>
<tr>
<td>37</td>
<td>8</td>
<td>Q1, Q2, Q3, Q4, Q5, Q6, Q7, Q8</td>
<td>MOSFET N-CH 75V 56A I-PAK</td>
<td>International Rectifier</td>
<td>IRFU3607PbF</td>
</tr>
<tr>
<td>38</td>
<td>3</td>
<td>R1,R44,R50</td>
<td>RES 10.0K OHM 1/16W 1% 0603</td>
<td>TE Connectivity</td>
<td>5-1879337-9</td>
</tr>
<tr>
<td>39</td>
<td>5</td>
<td>R2,R46,R73,R74,R75</td>
<td>RES 2.00K OHM 1/10W 1% 0603 SMD</td>
<td>Vishay Dale</td>
<td>CRCW06032K00FKEA</td>
</tr>
<tr>
<td>40</td>
<td>1</td>
<td>R3</td>
<td>RES 143K OHM 1/10W 1% 0603 SMD</td>
<td>Yageo</td>
<td>RC0603FR-07143KL</td>
</tr>
</tbody>
</table>
## Appendix A: Board Schematics, Board Layout, and BOM

<table>
<thead>
<tr>
<th>Item</th>
<th>Qty</th>
<th>Reference</th>
<th>Description</th>
<th>Manufacturer</th>
<th>Mfr Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>41</td>
<td>1</td>
<td>R4</td>
<td>RES 18.2K OHM 1/10W 1% 0603 SMD</td>
<td>Yageo</td>
<td>RC0603FR-0718K2L</td>
</tr>
<tr>
<td>42</td>
<td>3</td>
<td>R70,R71,R72</td>
<td>RES 8.20K OHM 1/10W 1% 0603 SMD</td>
<td>Vishay Dale</td>
<td>CRCW06038K20FKEA</td>
</tr>
<tr>
<td>43</td>
<td>1</td>
<td>R5</td>
<td>RES 16.9K OHM 1/10W 1% 0603 SMD</td>
<td>Vishay Dale</td>
<td>CRCW060316K9FKEA</td>
</tr>
<tr>
<td>44</td>
<td>1</td>
<td>R6</td>
<td>RES 9.10K OHM 1/10W 1% 0603 SMD</td>
<td>Vishay Dale</td>
<td>CRCW06039K10FKEA</td>
</tr>
<tr>
<td>45</td>
<td>5</td>
<td>R7,R45,R51,R63,R65</td>
<td>RES 1.00K OHM 1/8W 1% SMD 0603</td>
<td>Vishay Beyschlag</td>
<td>MCT06030C1001FP500</td>
</tr>
<tr>
<td>46</td>
<td>1</td>
<td>R10</td>
<td>RES 590 OHM 1/10W 1% 0603 SMD</td>
<td>Vishay Dale</td>
<td>CRCW0603590RFKEA</td>
</tr>
<tr>
<td>47</td>
<td>1</td>
<td>R9</td>
<td>RES, 5.49K OHM, 1%, 1/10W, 0603, SMD</td>
<td>Panasonic-ECG</td>
<td>ERJ-3EKF5491V</td>
</tr>
<tr>
<td>48</td>
<td>1</td>
<td>R11</td>
<td>RES 2.4K OHM 1/10W 5% 0603 SMD</td>
<td>Yageo</td>
<td>RC0603JR-072K4L</td>
</tr>
<tr>
<td>49</td>
<td>3</td>
<td>R12, R37, R39</td>
<td>RES, 330 OHM, 5%, 200PPM, 1/10W, 0603</td>
<td>Panasonic-ECG</td>
<td>ERJ-3GEYJ331V</td>
</tr>
<tr>
<td>50</td>
<td>10</td>
<td>R20,R21,R22,R23,R24,R25,R26,R27,R53,R57</td>
<td>RES, 22 OHM, 1%, 200PPM, 1/10W, 0603</td>
<td>Panasonic-ECG</td>
<td>ERJ-3EKF22R0V</td>
</tr>
<tr>
<td>51</td>
<td>3</td>
<td>R34, R35, R36</td>
<td>RES 0.03 OHM 1/2W 1% 1206 SMD</td>
<td>Rohm Semiconductor</td>
<td>UCR18EHFSR030</td>
</tr>
<tr>
<td>52</td>
<td>1</td>
<td>R38</td>
<td>POT 10K OHM 1/8W CARB VERTICAL</td>
<td>CTS Corporation</td>
<td>296UE103B1C</td>
</tr>
<tr>
<td>53</td>
<td>4</td>
<td>R40, R41, R46, R47</td>
<td>RES, 20K OHM, 1%, 100PPM, 1/10W, 0603</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-3EKF2002V</td>
</tr>
<tr>
<td>54</td>
<td>4</td>
<td>R42,R43,R48,R49</td>
<td>RES 2.40K OHM 1/10W 1% 0603 SMD</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-3EKF2401V</td>
</tr>
<tr>
<td>55</td>
<td>5</td>
<td>R52,R56,R60,R61,R62</td>
<td>RES 1.0K OHM 1/10W 5% 0603 SMD</td>
<td>Vishay Dale</td>
<td>CRCW06031K00JNTA</td>
</tr>
<tr>
<td>56</td>
<td>3</td>
<td>R76, R77, R78</td>
<td>RES 3.9K OHM 1/10W 5% 0603 SMD</td>
<td>Yageo</td>
<td>RC0603JR-073K9L</td>
</tr>
<tr>
<td>57</td>
<td>1</td>
<td>R82</td>
<td>RES 10.0K OHM 1/10W 5% 0603</td>
<td>Yageo</td>
<td>RC0603JR-0710KL</td>
</tr>
<tr>
<td>58</td>
<td>2</td>
<td>R83,R84</td>
<td>RES 1.80K OHM 1/10W 1% 0603 SMD</td>
<td>Vishay Dale</td>
<td>CRCW06031K80FKEA</td>
</tr>
<tr>
<td>59</td>
<td>1</td>
<td>R91</td>
<td>RES 4.7K OHM 1/10W 5% 0603 SMD</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-3GEYJ472V</td>
</tr>
<tr>
<td>60</td>
<td>3</td>
<td>R92,R93,R94</td>
<td>RES 220 OHM 1/10W 1% 0603 SMD</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-3EKF2200V</td>
</tr>
<tr>
<td>61</td>
<td>2</td>
<td>R103, R104</td>
<td>RES, 0.0 OHM, 1/10W, 5%, 0603, SMD</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-3GEY0R00V</td>
</tr>
<tr>
<td>62</td>
<td>2</td>
<td>SW1,SW2</td>
<td>SWITCH TACTILE SPST-NO 0.05A 12V</td>
<td>Panasonic</td>
<td>EVQ-PE105K</td>
</tr>
</tbody>
</table>

CY8CKIT-037 PSoC® 4 Motor Control Evaluation Kit Guide, Doc. No. 001-92562 Rev.**
## Appendix A: Board Schematics, Board Layout, and BOM

<table>
<thead>
<tr>
<th>Item</th>
<th>Qty</th>
<th>Reference</th>
<th>Description</th>
<th>Manufacturer</th>
<th>Mfr Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>63</td>
<td>2</td>
<td>TP1(GND),TP2(GND), TP13(+12V), TP14(Vin),TP15(VDD)</td>
<td>TP, TEST POINT, BLACK, TH</td>
<td>Keystone Electronics</td>
<td>5006</td>
</tr>
<tr>
<td>64</td>
<td>3</td>
<td>U1</td>
<td>IC REG BUCK ADJ 2.5A 20TSSOP</td>
<td>TI</td>
<td>LM5005MHX/NOPB</td>
</tr>
<tr>
<td>65</td>
<td>1</td>
<td>U2</td>
<td>IC, DUAL, DIFF, COMP, 8PIN, SOIC</td>
<td>Rohm Semiconductor</td>
<td>LM393DR</td>
</tr>
<tr>
<td>66</td>
<td>4</td>
<td>U3, U4, U5, U6</td>
<td>IC DRIVER HIGH/LOW SIDE 8SOIC</td>
<td>International Rectifier</td>
<td>IR2101STRPBF</td>
</tr>
<tr>
<td>67</td>
<td>1</td>
<td>U7</td>
<td>IC OPAMP GP 8.4MHZ RRO SOT23-5</td>
<td>Analog Devices</td>
<td>AD8601ARTZ-R2</td>
</tr>
<tr>
<td>69</td>
<td>1</td>
<td>U8</td>
<td>IC, CYPRESS, USB-UART LP, 512-BYTE FLASH, QFN-32</td>
<td>Cypress Semiconductor</td>
<td>CY7C65213-32LTXI</td>
</tr>
<tr>
<td>70</td>
<td>1</td>
<td>VR1</td>
<td>VARISTOR 67V 250A 1210</td>
<td>Littelfuse Inc</td>
<td>V60MLA1210H</td>
</tr>
<tr>
<td>71</td>
<td>1</td>
<td>PCB</td>
<td>CY8CKIT-037 MOTOR CONTROL SHIELD PCB (Size: 3.8 inch x 2.44 inch, No of Layers: 2, Surface Finish: ENIG, Solder Mask color: Red, Board thickness: 1.6 mm)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## NoLoad Components

<table>
<thead>
<tr>
<th>Item</th>
<th>Qty</th>
<th>Reference</th>
<th>Description</th>
<th>Manufacturer</th>
<th>Mfr Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>R105</td>
<td>RES, 0.0 OHM, 1/10W, 5%, 0603, SMD</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-3GEY0R00V</td>
</tr>
<tr>
<td>2</td>
<td>15</td>
<td>TP3(la), TP4(lc), P5(AH), TP6(AL), TP7(BH), TP8(BL), TP9(CH), TP10(CL), TP11(DH), TP12(DL), TP16(P0_2), TP17(P0_1), TP18(P0_7), TP19(GND), TP20(P2_6/VIN_SENSE)</td>
<td>TP, TEST POINT, RED, 0.063”D, TH</td>
<td>Keystone Electronics</td>
<td>5005</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>F1</td>
<td>PTC RESETTABLE 60V 2.50A KINKAMO</td>
<td>Littelfuse Inc</td>
<td>60R250XMR</td>
</tr>
</tbody>
</table>

## Special Installation Instructions

<table>
<thead>
<tr>
<th>Item</th>
<th>Qty</th>
<th>Reference</th>
<th>Description</th>
<th>Manufacturer</th>
<th>Mfr Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>11</td>
<td>J13,J14,J15,J16, J17,J18,J20,J21, J22,J23,J24</td>
<td>MINI JUMPER GF 13.5 CLOSE TYPE BLACK WITH HANDLE</td>
<td>Kobiconn</td>
<td>151-8030-E</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>SHUNT_J19</td>
<td>JUMPER SHUNT NON-INSULATED MALE .100&quot;</td>
<td>Mill-Max Manufacturing Corp.</td>
<td>999-11-110-10-000000</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>J12</td>
<td>ConWTB Wire To board Connector 2.50mm pitch, “J” type Female Terminal Housing, 5 Pins</td>
<td>Wurth Elektronik</td>
<td>688 005 113 322</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>J12 Hall sensor wire Crimping</td>
<td>2.50mm “J” Type Female Crimp Contact WR-WTB</td>
<td>Wurth Elektronik</td>
<td>688 001 137 22</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Qty</th>
<th>Reference</th>
<th>Description</th>
<th>Manufacturer</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>N/A</td>
<td>LBL, Kit Product Identification Label, Vendor Code, Datecode, Serial Number CY8CKIT-037 Motor Control EVK Rev**(YYYYVVXXXXX)</td>
<td>Cypress Semiconductor</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>N/A</td>
<td>LBL, QR Code, CY8CKIT-037 Printed Circuit Assembly, 13mm X 13mm</td>
<td>Cypress Semiconductor</td>
</tr>
</tbody>
</table>
## Revision History

### Document History

**Document Title:** CY8CKIT-037 PSoC® 4 Motor Control Evaluation Kit Guide  
**Document Number:** 001-92562

<table>
<thead>
<tr>
<th>Revision</th>
<th>ECN</th>
<th>Orig. of Change</th>
<th>Submission Date</th>
<th>Description of Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>**</td>
<td>4784695</td>
<td>ROWA</td>
<td>06/02/2015</td>
<td>New document</td>
</tr>
</tbody>
</table>